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Here we are at issue 3 of TUX. My hope is that we
have managed to help tens of thousands of people
belive that Linux can do what they want. Up until
now, our primary focus has been for a user with a
Linux system. That is, getting you comfortable with a
single Linux desktop system.

That’s a great start, and if you have done your
homework you know that Linux has been a very
serious player in the server market long before the
idea of Linux desktops for regular mortal computer
users made any sense. But, that still leaves a big
missing piece—your office.

Now, if Linux desktops make sense and Linux
servers make sense, it may sound like you are home
free. But, there is one big catch—maybe not every-
one in your office is convinced yet that Linux is the
right answer. Or maybe, just maybe, they actually
need to do something that can be run only on some
other computer platform.

Well, I have more good news. Linux systems play
well with others. That is, you can stick one or many
Linux-based computer systems in an environment
with other systems and the Linux system will fit in.

Let me offer an example from our past. I was at
Doc Searls’ house, one of the editors of our sister
publication, Linux Journal. Although Doc and his
wife were primarily Mac people, we had installed a
Linux system in his house and connected it to his
router so it had Internet access. But, that was all. It
wasn’t talking to the Macs.

I was at his house using the Linux system and
wanted to print something. He had a printer there,
but it was hooked to a Mac and I know more about
Cajun food than Macs. I first had a depressing
thought involving saving the print file to a floppy
disk in DOS format and loading the file on a Mac to
print it. But, I knew there had to be a better way.

I called up my then systems administrator in
Seattle and asked him if he knew an easy way to
deal with this. He said yes and rattled off one com-
mand to type in on the Linux system. That command
(apt-get install followed by the name of a partic-
ular software package) would instruct the Linux sys-
tem to go fetch this software from a repository on
the Internet, install it and configure it.

Although I was used to installing packages this
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way, I was worried because I knew noth-
ing about the Mac end. But, it clearly was
easy to try, so I did. In about ten minutes
the download completed and the pack-
age was installed. Everything looked nor-
mal to me other than I was concerned
that I had not been asked any questions
during the install process.

I printed a file. It came out on the
printer attached to Doc’s wife’s Mac. I
was impressed—not only with Linux but
with the fact that Apple had done its end
right such that a foreign system wanting
printer access didn’t have to ask a human
a bunch of questions.

But, things got better. Some time later,
Doc rebooted his Mac. He called me over
because something strange had hap-
pened—there was a new icon on his
desktop called happy. We both knew the
name of the Linux box was happy. I sug-
gested he click on the icon.

Sure enough, what I expected had
happened. Happy was simply another
node on Doc’s network now, and when
he clicked on the happy icon he saw the
filesystem of the Linux box. At that point,
he could drag and drop files between
Linux and the Macs.

I think Doc was more surprised by all
of this than I was. That is, I expected
Linux to play nicely with others, whereas
Doc just thought it was “different”.

There are good reasons for both of
these perceptions.

When a company has most of a mar-
ket, they tend to do whatever is necessary
to make it hard for new players to get
market share. An excellent example is
what Microsoft did with Word. Although
there already were document formats
available such as SGML, they decided to
create two new ones: .doc and RTF. That
put them in control of the standards, and
other companies had to play catch-up.

On the other hand, if you are the little
guy, you tend to do something new or
better in order to get market share. A
good example here might be Volkswagen
when they were new in the US market. I
remember signboards showing a VW that
just said $1.07/pound, and another that
was a huge pile of parts on one side and
a VW bug on the other.

These ads established the price point
they were at and, possibly more impor-
tant, that the car was merely a collection
of parts. When you considered that each
model year of a Chevrolet was quite dif-
ferent from the previous one, you quickly
could realize that it was going to be easi-
er to get replacement parts for an older
VW than an older Chevrolet because, in
most cases, parts for VWs didn’t change
from year to year.

Back to Linux—that is exactly what

happened. In order to get market share
where one vendor had most of the mar-
ket and a second had a significant portion
of what remained, it was important that
Linux be able to work with these other
systems. Thus, early on, Linux systems
were more than willing to communicate
with Microsoft Windows, Apple and
Novell networks. They also supported
Microsoft, Apple, UNIX and other 
disk formats.

Have things actually gotten better over
the years? Again, the answer is yes. Back
when I added happy to Doc’s network, I
had to go fetch some software off the
Internet. This was mostly because includ-
ing this (and other) software increased
the size of the Linux distribution. Today,
with most serious software distributed on
DVDs, and the price of a gigabyte of hard
disk space being less than $1, most distri-
butions would recognize the Mac net-
work neighbors and automatically load
and configure the modules necessary to
make this all play together.

So, don’t worry about convincing
your boss that the office needs to go to
Linux. Simply convince him that you
waste too much company time without
Linux on your desktop. Then you can let
Linux sell itself.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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Phil Hughes is one of the few people who can say that he pub-
lished information about Linux before I did. Indeed, he was into
Linux in a big way with Linux Journal, when I was just discover-
ing what Linux could do while working at the computer trade
journal InfoWorld.

Back then, I spent most of my time talking about how
easily businesses could replace all their back-end Windows
services with Linux, and none of the users would know the
difference. (Linux uses a program called Samba to provide
Windows networking services.) Indeed, if the users noticed
anything, it was that they were able to work without server
outages and down time, because Linux is so much more
stable than Windows.

Savvy Information Technology (IT) geeks caught on, and
many of them stopped upgrading their Windows servers and
replaced them with Linux, or added Linux boxes to their server
farms. Few, if any, members of the management above them
even knew this was going on. All they knew was that the users
were happier with the stability, and in some cases (those cases
where office politics didn’t dictate that you never reduce a
budget), budgets and costs decreased.

I’d like to think I can take credit for much of this stealth
strategy of moving from Windows servers to Linux servers. I
was essentially the only person explaining it and recommending
it in the mainstream corporate press. Other mainstream publi-
cations seemed to follow suit only when the Linux geeks came
out of the closet and confessed they were using Linux instead
of Windows. The delay probably was due to the fact that writ-

ers at other publications weren’t using Linux and had no direct
experience. I had Linux installed everywhere I could install it, so
I saw the benefits first-hand.

Okay, now fast-forward to the present. We’ve already estab-
lished that it doesn’t matter whether you are using Windows or
Linux at the server end. Both can provide Windows file and
print services (among other things), and users need not know
whether the computer providing these services runs Windows
or Linux.

But the point is that these servers are providing Windows
services. (Yes, many of them provide UNIX-based or Linux-
based services, but most companies, big and small, are still
stuck in Windows mode.) So for Linux to succeed at the desk-
top at the moment, it must be able to use Windows services.

In fact, Linux has been able to connect to Windows services
for a very long time. What has changed in recent times is how
ridiculously easy it is to make use of Windows services from
within Linux. Only a few clicks in Konqueror will get you to all
of the Windows shares (shared directories and disk drives). You
also can access printers connected to Windows servers (or
Samba servers masquerading as Windows servers).

It is one thing to access Windows resources from a Linux
desktop; it is quite another to run Windows applications on
Linux. You may ask, “why would anyone want to run a
Windows application on Linux, because there are so many
applications from which to choose that are native to Linux?”
Do you want an Office Suite? Try OpenOffice.org, KOffice or
EIOffice. Want a word processor? Try OpenOffice.org Writer,

Linux Does Windows
Linux is easier for Windows tasks than you can imagine.
BY NICHOLAS PETRELEY

FROM THE EDITOR
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KWord, EIOffice or AbiWord.
In contrast, Microsoft has done such a

good job of eliminating competition on
Windows that the only relevant office
suite on Windows is Microsoft Office, and
the only relevant word processor on
Windows is Microsoft Word. When I stud-
ied music theory/composition, a popular
joke in music departments was the state-
ment that Beethoven wrote only three
symphonies—the third, the fifth and the
ninth. (For those who aren’t in the know
about classical music, these are the three
most popular Beethoven symphonies.
One rarely hears anyone perform the oth-
ers.) Likewise, there is only one word
processor for Windows, and that is
Microsoft Word. If there are others, they
are essentially irrelevant.

Sure, you can run OpenOffice.org on
Windows, but if people switch to it from
Microsoft Office, the switch will be grad-
ual because Microsoft Office has become
the de facto standard. Many publishers
for whom I write insist that I submit my
work in Microsoft Word format. They use

a lot of special formatting, so I can’t use
OpenOffice.org and then save my work 
as a Microsoft Word file. Much of the 
formatting will be lost, because
OpenOffice.org simply doesn’t translate
the files well enough.

So what’s a mother to do? You can pur-
chase CrossOver Office, by CodeWeavers
(http://www.codeweavers.com). It does a
superb job of running Microsoft Office
on Linux, especially Microsoft Word. 
I use CrossOver Office every time a 
publisher requires Word documents.
That way I never have to leave Linux to
do my work. There are other solutions,
such as Win4Lin or, if you are savvy
enough to configure it, you can use
Wine, which runs Windows applications
much the way CrossOver Office does.
(This is not surprising. CrossOver Office
is based on Wine.)

Win4Lin (http://www.netraverse.com)
is a quite different approach to Windows
compatibility on Linux. Win4Lin lets you
install and run Windows 95/98/SE/ME as
a separate application under Linux. The

new Win4Lin Pro 1.1 lets you install and
run applications for Windows 2000 or
Windows XP on Linux. That’s right. You
get the whole Windows desktop in a sep-
arate, resizeable window. (You can run it
to use the full screen too.)

Finally, there are native Linux pro-
grams that emulate Windows programs
so well that Windows users will feel
immediately comfortable using them. For
example, Evolution is an Outlook clone
that is even more feature-rich than
Outlook, and it works with Microsoft’s e-
mail back ends, such as Microsoft
Exchange. EIOffice is a Java-based Office
Suite that runs on Linux, and it emulates
Microsoft Office applications practically
down to the last pixel.

Regardless, when it comes to inte-
grating Linux into a Windows environ-
ment, or vice versa, it’s now a breeze.
And, it is one more step toward making
it easy for Windows users to switch to
Linux without having to relearn anything
or having to sacrifice the features to
which they’ve become accustomed. If
anything, they’ll find Linux to be more
feature-rich, more reliable and more
secure than Windows.�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and Linux analyst for Evans Data Corp.
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Reading the Small Print
I have problems reading the magazine because
when I zoom in to a readable level, I have to toggle
around the screen to follow the columns side to side
and up and down, which makes it hard to keep my
place. Any chance of a large-print version for people
with poor eyesight and plenty of bandwidth?

Following on from this, I wondered if you can do
an article on accessibility tools? For example, using
xmms is nearly impossible because of the insanely
small size of the writing on the interface, and I’ve
found no way of sizing the interface up. I’ve seen
one magnifying glass on a Knoppix distro—are
there other similar tools?

I managed to set up my desktop comfortably on
Xandros, perhaps a few tips for various systems?

I use Opera as a Web browser, which has a nice
handy “eye” for adjusting viewing size, but if I
click on a link from an e-mail, the eye isn’t visible.
Is there any way around that one?

I’m sure you can find all kinds of examples of diffi-
cult-to-use interfaces and ways around them. Bear
in mind also that although many of these inter-
faces have ways to make reading easier, you have
to be able to see them well enough to do the set
up in the first place, and not everyone has some-
one available to do that for them, and most
would prefer to be able to do it independently.

Perhaps it is worth pointing out to young pro-
grammers that it is easy for those with good eyes
to reduce a large default text size, but it is very
difficult for people with poor eyesight to increase
a small text size, because they have to read the
small print to do it.
--
Valerie Higgins

First, let’s talk about xmms. The default xmms skin
is insane. Only a few species of hawks can make
out something that small, and they have to do it
from a distance of several hundred yards. I’m con-
vinced people just click around until they hit
something that works. Either that, or they down-
load and use an xmms skin that is more sane. In
my personal experience, most alternative skins are
just as tiny, but some are large enough to be
usable. Most Linux distributions make a package
of xmms skins available (in Debian, type apt-get
install xmms-skins). You can also find xmms
skins all over the Web. Just do a Google search.

As for your more general question, let’s sum it up
this way. How can elderly and vision-impaired
folks cope with small text? A 32-inch monitor will
do the trick (just kidding, unless you’re filthy rich,
in which case I’m not just kidding). On a personal
note, when my vision was impaired by Bell’s Palsy,
I found it useful to put a pair of those magnifying
reading glasses you can get at most drug stores
over my normal glasses. It was uncomfortable, but

it worked. Beyond those suggestions, we’ll for-
ward the question to Mango and see if she has
any better answers.—Ed.

Installation Help
Just read the second issue of your magazine. In a
similar thread to most of the letters in the P2P
section, I would like some help. My main problem
is setting up various bits of hardware (mainly net-
work-based). My LAN card was fine (easily detect-
ed and configured by SUSE’s YAST), but trying to
set up a wireless card to share an Internet connec-
tion, or the setup of my own USB modem, has
left me completely frustrated. No end of forums,
questions or suggestions and downloads have left
me feeling this is an impossible task. I suppose the
area I struggle with is installing programs and driv-
ers to support the various bits of kit I am trying to
use. It just seems so complicated—having to
extract files and then compile them just to run an
install, only to be told that I don’t have the right
compiler and need to install that as well! I realise
there is a big difference between Linux and
Windows, but when it becomes this difficult to set
up relatively simple hardware/software, I can
understand why many people are put off Linux. In
a round-about way, what I would like to see are
some basic step-by-step guides to installing new
software (in various ways) and new hardware as
described above. I hope I’m not being too selfish,
but simply having not to revert to and fro
between windows (with my Internet connection)
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and Linux so I can get some information
on other issues would be a great help.

By the way, I think the layout and presen-
tation of the magazine are excellent.
--
Steve Harrison

Agreed. The current state of wireless net-
work support, especially USB adapters, is
pitiful. It can be done, however, if you
piece together many bits of information
available on the Web. We’ll commission
someone to do just that and publish an
article on this topic.—Ed.

Disturbed by Mango
I am very disturbed by some of the com-
ments made by Mango Parfait in the May
2005 issue. Here they are:

Potential anti-Semitic slur: “Jew Jitsu”
learned in Israel, New York and Florida.
Personally I would like to conclude that this
is probably not anti-Semitic in the context
it was written, although it could VERY easi-
ly be taken that way. She is probably refer-
ring to a form of martial art used by the
Israeli special forces called Krav Maga—
and no, it is NOT called “Jew Jitsu”. She
should have just kept her mouth shut, and
I am surprised this made it past you!

Disability slur: Using “GIMP” as a syn-
onym for crippled. She obviously doesn’t
think before she writes (or speaks).

These comments are at the very least in
extremely poor taste and have absolutely no
business in a technology magazine. As a
veteran *NIX sysadmin, I would not have
really read your magazine, but it was posted
on our local users group mailing list. These
comments were also posted by another
member, and I am sure you will be getting a
few more of these types of letters about her
comments. IMHO, you new magazine is
really getting off on the wrong foot.
--
Scott Phelps

Mango assures me that it was all in good
fun. She says “Jew Jitsu” was not supposed
to refer to any valid form of martial arts.
She took a pun (Jiu/Jew) and ran with it. In
fact, although Mango is Japanese, she tells
me she is a passionately strong supporter
of Israel. I warned her that making such a
statement is likely to offend someone much
more than “Jew Jitsu”. But Mango insists
she is entitled to her opinions, so I faithfully
record it here. Making friends and enemies
is an occupational hazard when expressing
ANY opinions in print, and she is apparent-
ly willing to deal with it.

As for The GIMP, I’ll address that com-
plaint, myself. I think anyone who takes
offense at this particular pun is seriously
over-reacting. It is sad state of affairs that
people have become so sensitive that
they can’t have a good laugh at a pun—
especially when the context Mango used
was one of turning the person into a
GIMP (something she would obviously not
do in real life). There is no possible way to
twist that into Mango making fun of
someone who is already handicapped.

As for being offended, I am personally
offended that such trivial puns would be
taken so seriously and criticized by what
amounts to thought police.—Ed.

Reveal the Alchemy
I just received issue 2 and am impressed
to see this logical step toward introduc-
ing Linux as a true alternative to the MS
autocracy. As Andrew aptly stated in
issue 2’s Letters, I agree that the jargon
has been the main intimidator to the
dissemination of Linux. The covenstead
of the UNIX high priests has been discov-
ered and the closely guarded alchemy
must be revealed.

I like the clean format and concise con-
tent, albeit, the Mango Parfait column is
a bit adolescent. Hopefully it will settle
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into a straightforward Q&A.

To cut to the chase, I am viewing your
fine publication on Windows (hiss—boo)
due to the fact that I am having a heck of
time finding USB drivers for SUSE 9.1.
Specifically, my Orinoco Proxim wireless
adapter and Lexmark X80 printer (I know,
I should get a PostScript machine on a
parallel line).

I use KDE, although as a Comp Sci stu-
dent in a UNIX environment, I usually go
right to the terminal. As a novitiate into
the UNIX priesthood, I would appreciate
this further assistance down the path of
enlightenment (koans notwithstanding).
Keep the faith.
--
Brian Sexton

Yay Landscape Format!
In yet another example of you can’t
please everyone, I think that the previ-
ous letters that complained about your
landscape PDF format were totally
wrong. I think it’s about time that digi-
tal magazines adopt a landscape for-
mat so that I can read the entire page
with scrolling back and forth on the
same page. Bravo!
--
George

Translate TUX
I live in Haifa, Israel, and came across your
fine magazine by chance. I really like it! It is
great for advocating Linux for newcomers. I
initiated the Jerusalem Linux Club two years
ago, in part, because I wanted to advocate
GNU/Linux to others—to show them what
they are missing. I have since had to move
to Haifa, but I never miss a chance to tell
people around me what a great OS
GNU/Linux is. I had an idea I wanted your
opinion on—I thought it could be nice if it
was possible to translate the magazine to
other languages, Hebrew, for instance. It
would be a lot easier to sell GNU/Linux if
we had a magazine like yours in Hebrew.
--
Amichai Rotman

Need a Genealogy Program
I have glanced through your first two edi-
tions and think that you have come up
with great idea. I am retired (now 78), and I
have been using Linux for three years. I
have two problems: 1) I would like to drop
MS completely but am unable to find a
genealogy program that will run on Linux
without requiring dependencies that I
know nothing about. 2) It is difficult getting
a new install to work without the correct
driver. These are hard to get and to get the
right one. I would like to load Fedora Core
3, but I am not sure about the driver for

the modem. I understand that GNOME has
come out with a GPPP that will connect
without any problems. I use mostly KDE
but also like GNOME. Nowake 10.
--
Herb Taylor

Easy Symlinks
Judging from what I’ve read in the article
“Linking Users with Their Data” [TUX,
May 2005], I’d say TUX has been playing
for too long with Konqui and maybe it
should spend some time with GNOME. I
started to feel a bit lonely after reading
the article.

To create symlinks in Nautilus, instead of
creating the link, cutting it and pasting
the darn thing where you’d like it to be,
try pressing the mouse wheel and drag-
ging the file (or directory) to wherever
you want it. A few options should appear,
namely Move, Copy and *Create Link*.
This way, which is just as easy as in KDE,
also allows you to create symlinks from
Windows partitions, which goes against
what was stated in the Q&A section.

BTW, although I feel that TUX Magazine is a
bit KDE-biased, I hope it gets some traction
because it seems a really nice idea.
--
Celso
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So Many Questions
I have been using Linux for a whole three
months now, and I have some concerns
that might make for a good article or
two. First, coming from Windows, I
would like to know the scoop about
antivirus programs on Linux. When I ask
about them I get told that winning the
lottery is more plausible than getting a
virus in Linux. Is this true? If so, why do
Linux antivirus programs exist? Which one
should I use and why? Another security-
related question is about firewalls. Which
one should I choose? Firestarter,
Gaurddog, Snort or one of the others?
Are firewalls necessary on a Linux
machine? Is there absolutely no spyware
for Linux? What is a root kit and what is
RKhunters purpose? What other dangers
should I be concerned about when using
Linux? This may all seem paranoid, but,
hey, I am new and I come from the land
of Microsoft where all doors are locked
and Windows barred.
--
James Roettger

I suspect that the abundant examples of
Linux antivirus software to which you are
referring are programs that are meant for
Linux machines used as mail servers.
These programs detect and stop
Windows viruses from reaching Windows

clients. They don’t intercept or disinfect
Linux viruses. Indeed, although there have
been some viruses, worms and trojans
that exploited flaws in programs like
Apache, I am not aware of any Linux-spe-
cific viruses that pose a danger to any
recent distribution.

Firewalls are a good idea on any machine
that you connect directly to a network,
and a necessity if you connect directly to
the Internet. If you connect to the
Internet via a cable/DSL router at home,
and have the router properly configured,
there is little if any reason to run a fire-
wall on your Linux machine.—Ed.

Again, Yay Landscape Mode
I just subscribed to TUX magazine today
and can’t yet say much about it except I
have liked everything I’ve seen so far
(well, except TUX being KDE-centric—I’m
using GNOME).

In the May issue, there is a letter from
a reader who writes very negatively
about the format you use for the mag-
azine. In my opinion, the landscape
mode is by far the best choice for on-
screen reading. Actually, having to read
PDF documents in A4 (or similar) for-
mat is perhaps the most important rea-
son why I have never really liked read-

ing PDF documents. In A4 format, you
often have to move up and down on
the page when you move between dif-
ferent paragraphs. Now the whole
page fits on my screen, 1024 x 768,
and I’m very happy.

Landscape mode probably isn’t best
suited for printing, but how many peo-
ple actually print the magazine? Some
people may have a good reason for
doing that, but I think that for many
people it’s just a bad (environmentally
at least) habit to print documents for
reading—especially when we are talking
about a well-formatted PDF document;
reading it on your computer screen
shouldn’t be a problem. Text documents
(.doc, .rtf, .txt, etc.) are another matter;
they can be unpleasant to read on-
screen—I’m not surprised if someone
wants to print them.
--
Ari Torhamo

Correction
Just wanted to mention that in the
review of AbiWord recently [TUX, May
2005], your reviewer couldn’t find the
PDF exporting tool. On both my
Windows machine and my Linux laptop,
I run AbiWord often, and you can make
a PDF by going to the File menu and
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clicking print. The PDF distiller should be
one of the options for printers. Even if it
is not (for some reason), you can always
print to a PostScript file and then con-
vert to a PDF with one of the many tools
out there! Loved these two issues, can’t
wait for more!
--
Chris Giroir

Well, dang if you ain’t right. We sit cor-
rected. You can create a PDF file from
AbiWord using the print option.—Ed.

TUX’s Publishing Process
I found your magazine today. The Open
Source world is a worthy and exciting
place, but its natives are sometimes very
intimidating to those of us yet to have
completely defenestrated. Thank you for
a publication that helps those of us keen
to USE this amazing work.

I would be very interested to know more
about your publishing process. The maga-
zine layout and design is very pleasing to
the eye and is easy to navigate and read.
Would you be revealing too many secrets
by describing the process from layout to
PDF publication?
--
Steven James

Phil Hughes responds:

I have worked with those natives for a lot
of years and I totally understand. And,
yes, TUX is designed to be as knowledge-
able as them without the geek baggage.

Regarding layout—nothing magic here,
yet. The production is currently exactly
the same as Linux Journal, but it will
change. The pieces are:

� Article input in text.

� Tagged (using vi) as pretty much
DocBook XML.

� Run through a filter program to pro-
duce Quark-tagged files.

� Imported into Quark to produce a
PostScript file.

� Adobe Distiller to make the PDF and
add some stuff.

The change is to go to using Scribus.
We are working on the template right
now and hope to have issue 4 done
with Scribus.

Use xpdf
I notice a lot of whining about the PDF
format and stuff to do with acroread.
I’ve just read your magazine using xpdf
with no problems other than the
obtuse message:

"Warning: Cannot convert string
"-*-times-medium-r-normal--16-*-*-
*-*-*-iso8859-1" to type
FontStruct"

in the controlling shell window, but
there’s no pop-ups about some features
not working, or opening in full-screen
mode or anything weird. I suggest every-
one use xpdf in preference to acroread.
--
Jim Jackson

Another PDF Viewer
I have been a user of Linux for some time.
I currently use it most often on my older
IBM ThinkPad. I can accomplish things on
this old Pentium II that I would not dream
of trying under Windows. Two programs
that help greatly are my X Windows desk-
top XFCE and Firefox/Thunderbird. They
are both streamlined and better for my
nearly thin client computer. As to reading
your magazine, I had no problems using
gv (ghostview) and viewing full pages at
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my max resolution of 1028x764. You
mentioned using various PDF viewers but
left out this old standby reader. It is
extremely easy to add a launcher to it: in
XFCE, right-click on the launcher, select
add launcher, type gv on the command
line, ghostview in the tooltip, and select
an icon (I use the PDF one buried in
usr/share/icons/Rodent/48x48/mimetypes).
I would recommend unchecking the box
for attach menu to launcher.

I love your work. I would recommend TUX
to anyone thinking about switching to the
penguin OS. I wish it would have been
around a few years ago; it would have saved
me many hours of reading man pages and
doing infoseek searches for answers.
--
Jay Fude

No Postal Mail Please
Your sign-up form combines permission
for e-mail and postal mail solicitations. I
don’t mind getting e-mail, but I don’t
want postal mail. As a consequence, I
chose no. You might want to split this
into separate questions.
--
Robert Morrison

Noted. We’ll put that up for discussion.—Ed.

And Again, Yay Landscape
Mode
Thanks for publishing TUX. I’ve been sub-
scribing to Linux Journal for a while, hop-
ing for a few scraps of information that
are understandable for non-gurus, but
TUX is much better food for me! I just
read one of the letters in the May 2005
issue that complained about landscape
mode for TUX. I strongly disagree and
find it extremely awkward to read two-
column documents in portrait mode.
Scroll down, scroll up, scroll down,
next page. Repeat ad nauseum.
Portrait-shaped monitors are extremely
rare, so I’m glad to see you’ve created
a landscape document that matches
the 99.99% of monitors/screens that
are landscape-oriented. Keep up the
good work
--
K Wright

Palm Version?
I have recently subscribed to your excellent
magazine, and I must say that I am enjoy-
ing the content so far. However, all is not
perfect. Like many of your readership, I am
a mobile worker and am not at my desk
very often. When I received issue number
2, I thought to myself, “I know, I’ll transfer
the magazine to my Palm and read it
whenever possible.” However, when I

attempted to do this I was prevented
because the security settings made it
impossible to successfully carry out the job.
Is it possible for you to make a Palm version
available or perhaps change the settings of
the security so that it allows transfer to
other devices? I look forward to your reply.
--
Damian Turner-Steele

A Request
First, thank you for producing such an
excellent magazine. I really enjoy it. The
article about digiKam was interesting.
However, knowing the version of the soft-
ware under review would be helpful.

The digiKam article talks about tags for
photos. Great! I thought, just what I
need. Alas, my distribution Mandrake
10.1 comes only with digikam-0.6.2. The
tags feature does not appear until
digikam-0.7.0. Granted, digikam-0.7.0
has been available as source since
November 2004. Although compiling is
not difficult, it is not a typical activity for
the new Linux user—your target audi-
ence. Mandrake, now Mandriva, will not
release 10.2 (Mandriva 2006) until the
end of this year, as they are now on a
yearly release cycle. As the author is a
KDE developer, you would expect him to
have the latest version.
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Could you please include the version of the
software and consider its availability to the
average new Linux user in future issues?
--
Greg Thomson

Good suggestion. Done and done. Well,
at least we’ll do our best.—Ed.

Don’t Preach
I would like to say I like the idea of your
magazine. However, I was greatly disap-
pointed in the first article, “Choice and
Excitement Make a Comeback” [TUX,
March 2005].

As an independent network consultant, I
do a variety of things for a number of
clients. Often I will go to a client and start
recommending Linux, and the client will
be immediately turned off. Often I will
find it is because some Microsoft-hating
consultant was just let go for preaching
much of what I saw in this article. When I
sit down and rationally show them their
options, their opinion often changes. It is
my belief that as a consultant, it is my job
to fully understand the client’s need and
recommend what is best for them. If this
means a Microsoft solution best fits his or
her needs, then I will recommend the MS
solution. If a Linux solution fits better, I
will recommend it. Along with my recom-

mendations, I present the pros and cons
of both sides. I find this brings me much
more business, as well as repeat business,
than going in and preaching the moral
high ground of Linux.

I received a link to your magazine through
my local LUG, and my first thought was
this will be great, I can recommend a
number of my clients to you in order to
broaden their knowledge of some of the
things I have implemented in their offices
in the past. It will be an inexpensive way
for them to get more out of what I have
put in place. I will read the rest of this first
issue this weekend, and it may still be a
possibility that I will recommend it to
them; however, if I get the same feel from
the rest of the magazine as I did from this
first article, many of my clients would not
appreciate the recommendation.
--
Jeff Miller

There’s nothing wrong with recommend-
ing a Microsoft solution when it is appro-
priate. I hope, however, that you are con-
sidering the lock-in consequences of rec-
ommending a Microsoft solution. Lock-in
is a very serious consideration, for at least
two reasons. Microsoft typically abandons
innovation when it has eliminated compe-
tition. So the solution that is right today

could stagnate tomorrow and leave the
client with unmaintained software.
Microsoft also has a habit of finding ways
to increase the cost of ownership once a
client is locked-in. These considerations
are just as important as whether or not a
solution has the right features for the
right price—today.—Ed.

Games Please
I am a recent subscriber to your on-line
magazine, and I am very happy about the
prospect of the periodical. I myself am a
relative new-comer to the Linux world, so
I know relatively little about the workings
of Linux. I am currently building a com-
puter that will utilize the 64-bit processor
that AMD makes, so I will be installing
the SUSE version 9.0 with the 64-bit
capability once I get all the parts. I am a
teenager, and so I would like to play
games. I love the games made for Linux;
however, I would like to be able to play
more mainstream games. I was wonder-
ing if you could do an article that focuses
on getting games/applications that work
only with Windows to work with Linux.
I am hoping that this is possible,
because if it is I am going to change all
my computers to Linux and thumb my
nose at Windows.
--
Will Sternberg�
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Q As a Windows refugee, most of the
MS programs I used are a distant

memory; however, there is one I miss and
would really like to see either ported to
Linux or mimicked. That program is
ShortKeys. It is simple. I set up the key
shortcuts and it types the word for me. As
an example, if I want to type my company
name, MobileMaster of Austin, with
ShortKeys, all I have to type is mmm, and
it happens. I have looked at khotkeys, but
not only is it very complex, there seems
to be some real problems with the soft-
ware. I have been in contact with the
author of ShortKeys, and he has told me
he has no interest in Linux. Is there any-
thing comparable in Linux? Can you
help?—Ken Starks

A This question was forwarded to
me from last month’s Letters. It is

a good question. For those who don’t
know ShortKeys, here is how it works.

You define and type a key sequence
that would be bonkers to type for real.
Example: #(^. This nutty key sequence
wakes up ShortKeys and tells it to
expand the next thing you type. Kenny
might type #(^mmm and that would
make ShortKeys insert MobileMaster of
Austin into the program he is using.

You don’t mind if I call you Kenny,
do you? After all, we seem to have
something in common. I like Steve
Austin too, especially when he played
the six dollar man (it is not a well
known fact that six dollar man was the
name of the series pilot, which was
filmed long before there was so much
inflation in the economy).

It may be daring to write this kind
of program for Linux because there
would be two technical hurdles to
jump. Some programs could make 
it difficult to capture the “trigger”
keystrokes #(^ and the shortcut, and
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Q&A with Mango Parfait
Mango Parfait short-circuits a way to emulate ShortKeys, gives not-so-short advice on trying

Linux and shorts out an impossible printer problem.

BY MANGO PARFAIT

This month, I mix my own questions
with some of yours, since deadlines
prevented me from answering ques-
tions arriving after last month’s 
column (giggles). Wow, I haven’t 
gotten so much mail since I was a
member of the Dæmon-Kill9ers and
defeated Oni, the evil uniXverse lord
of zombies. Like I said last month,
between my busy social life and 
conquering IT problems and evil 
dark powers, I cannot answer your
mail directly. I choose questions I
think should benefit the most people
and answer them here. Thank you 
for the magnificent response so far!
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some programs might make it difficult
to paste the expanded MobileMaster of
Steve Austin properly because different
programs have different paste rules. An
expert Linux programmer could detect
those special cases, so I am bewildered
that there isn’t a program already like

this for Linux. I am even more baffled
as to why I, myself, haven’t created it
yet. But, sweetie, you should know
that a single girl as cute as I am has a
life to live, and doesn’t need more pro-
grams to write.

Here is what you can do. You can trick

the OpenOffice.org productivity suite to
have this feature. Start up OpenOffice.org
Writer, the word processor. Then, click on
the Tools menu and select
Autocorrect/Autoformat from the
menu. The first thing you should see is
a replacement table (see Figure 1). The
real purpose of this table is to correct
common typing mistakes automatically.
But you can use it to create shortcuts
like yours. Look at Figure 1 to see
where I entered mmm in the first field,
and MobileMaster of Steve Austin in
the second. Do the same and then click
on the New button to add this replace-
ment to the list. Now whenever you
type mmm and then press the spacebar
in an OpenOffice.org application, it will
replace mmm with MobileMaster of
Steve Austin. You always can add the
prefix #(^ if you are the kind of guy
who likes to make things more difficult.

You can do the same thing with any
program that has an autocorrect feature
like this. KWord, the KDE word processor,
has this feature too. Click on Settings in
the main menu, then select Configure
Autocorrection and a tabbed dialog will
appear. This time, you have to choose the
tab called Advanced Autocorrection. The
rest is pretty much the same as what you
did in OpenOffice.org.
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Figure 1. Use OpenOffice.org to work like ShortKeys.
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Q Are you a natural blond?—
Bakabakashii Shimon

A Is that a polite thing to ask a humble
sensitive genius like myself? But

since you asked, the answer is no. My hair
is naturally blue. I dyed it blond so I could
look more like an American. If I were a
natural blond, I wouldn’t be able to write
this column, because I would be too busy
trying to put M&Ms in alphabetical order. I
am not that stupid. Not always, anyway. It
is to my shame to admit that when I stud-
ied flute in high school, I saw the word
diminuendo on the music sheet and at
first I thought it was the Italian word for
inserting a suppository in the dark. No
need to say it was embarrassing when I
tried to do that during rehearsal.

Q Hi, I am a new—and I do mean
new—user to Linux. Just toying

around with Phatlinux (free with the
Linux+ Bible) and I would like to try
another kind. Since all Linux appears to be
okay, would you have a recommendation
as to what other flavor to try first? I have
heard that Mandrake is very good, also
SUSE.

Any recommendation and/or advice
would be helpful. I am very open (no pun
intended) to open source, and I look for-
ward to your reply.—Gary Lange

A Jeepers. I knew that some people
are religious about open source, but

I didn’t know you could get Phatlinux free
if you bought Linux plus a Bible. I visited a
Christian book store, and they had Bibles
but didn’t have Linux at all, so I guess that
combo deal is not available in my area.

Anyway, you can’t go wrong with
SUSE or Mandrake. I chose SUSE over
Mandrake because one of my best friends
is named Susie. If you knew Susie like I
know Susie, you’d like SUSE, too. Also,
ever since Novell bought SUSE, SUSE has
gained more credibility and market share.
It is a good thing to use a Linux that
many others use because you can find
answers to problems more easily. Of
course, lots of people use Mandrake, too,
but SUSE is more likely to grow faster
because it is owned by Novell.

If you think like me on that, you will
think it pays to try the most-popular
Linux. Well, it doesn’t pay like they send
you money or anything. But it is a good
thing. The most popular Linux is Red Hat,
and the free version of Red Hat is Fedora
Core. There are plenty of places you can
buy the Fedora Core CD set. Cheeplinux
(http://www.cheeplinux.com) is one place,
but you should do a Google search to get
the deal you like the best. You also can
download CD images from one of the
mirror sites (see http://fedora.redhat.com)

and burn your own Fedora Core CD set if
you know how to burn CD images.

One good thing about Fedora Core is
that it is very user-friendly and makes a
great desktop system. It almost never
makes you log in as root (the user that
can do the most damage to your system)
and edit files in order to make configura-
tion changes. To give you an example,
you change your network card settings by
selecting a menu option. It will ask you
for the root password and then pop up a
graphical network configuration tool.

One bad thing about Fedora Core is
that it expects you to use the GNOME
desktop. GNOME isn’t a bad desktop, but
it suffers from multiple personality disor-
der. One minute, the designers assume
you have an IQ of 3, so they rip out any
features that might be confusing for a
person with an IQ of 3. Then there are
features in GNOME that you can find and
use only if you hold a séance and make
contact with the GNOME spirit for
instructions. These features usually make
you edit the registry. If you are familiar
with Windows, you should know that
editing a registry is not only the opposite
of user-friendly, it is dangerous. In this
case, it is the GNOME designer who had
the IQ of 3.

If you like GNOME better than KDE,
don’t bother calling me for a date,
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because we are totally incompatible. But
if you like KDE over GNOME, you can
make KDE your default desktop. You still
can’t call me for a date since I am trying
to kiss and make up with my ex-
boyfriend, Otaku, but that’s another story.

If you find out that you like Fedora
Core, you will soon notice that your choic-
es of software packages is very limited. If
you are happy with the software you get,
then assume the position “if it isn’t broke,
don’t fix it.” If you are unhappy with the
selection of software available, you can
add software repositories to Fedora that
let you choose from a bigger selection.

You can find a lot of Fedora reposito-
ries on your own, but be careful not to
add a repository that contains software
that is incompatible with Fedora Core.
Some of the packages may install fine,
but you eventually will break your system.

I recommend adding the dag repository
because the software doesn’t break
Fedora Core. Here is how you can add the
dag repository. Warning: you have to log
in as root and create a file as root, and the
root user is the most dangerous user on
the system. If you are using GNOME,
right-click on an empty space on the desk-
top and choose Open Terminal from the
pop-up menu. Type these commands in
the terminal, being careful to type them
exactly as you see them here (with the

exception of the password instructions):

The next time you update your system,
it will search the dag repository in addition
to any other repositories you have activat-
ed. Dag has a lot of packages you won’t
find in the normal Fedora repositories.

For my last advice, you should try out
MEPIS (http://www.mepis.com) and
Knoppix (http://www.knoppix.org) too,
just because they’re so easy to try. You
don’t have to install them on your hard
drive. They run from the CD. They run
slower from a CD, but it is a great way to
find out if you like them. If you like one
of them, you can install it to your hard
drive and use it as your Linux distribution.

The only problem with MEPIS is that it
sounds like a disease. If you like a girl and
talk to her, make sure you say “I use
MEPIS” or “I run MEPIS” instead of “I
have MEPIS”, otherwise she might think

you have something contagious and
won’t go out with you.

Please see the two articles on MEPIS in
this issue [pages 24 and 46]. I also wrote
more about MEPIS and Knoppix in last
month’s issue, so please read that if you
are interested.

Q I have two printers connected to my
Linux server. One is a laser printer I

use for printing reports, and the other is
an HP color printer I use to print photo-
graphs. I use the CUPS printing system. My
problem is that sometimes these printers
work, and sometimes they don’t, and I
can’t figure out why. It’s like they have a
mind of their own, and decide one day to
work, and not work the next day. What’s
going on?—Secret Squirrel
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$ su -

Password: <type root password here and press enter>

# cd /etc/yum.repos.d

# echo "[dag]" > dag.repo

# echo "name=Dag RPM Repository for Fedora Core" >> dag.repo

# echo # "baseurl=http://apt.sw.be/fedora/\$releasever/en/\$basearch/dag" >> dag.repo

# echo "enabled=1" >> dag.repo

# echo "gpgcheck=0" >> dag.repo

# exit

$ exit

http://apt.sw.be/fedora/\$releasever/en/\$basearch/dag
http://www.mepis.com
http://www.knoppix.org
http://www.tuxmagazine.com


A Okay. You are using CUPS (Crappy
UNIX Printing System). You have

both printers connected to the server
with USB. I will assume your system is
using a combination of hotplug and udev
or some similar combination to create a
printer device (somewhere in the /dev
directory, maybe /dev/usb) only when it
detects that a printer is connected,
because this usually is the problem.

There are a lot of things that make
one Linux system different from another.
So not all people will experience this
same problem, or if they do, it may have
a different cause. Here is the usual cause.
Your Linux system detects some connect-
ed printers even when they are turned
off. Sometimes it cannot detect a printer
unless it is plugged in and turned on.

Let’s say you connected only the laser
printer and turned it on. Come on, let’s
say it: “I connected only the laser printer
and turned it on.” Very good. Linux saw
the printer and created the first printer
device (maybe /dev/usb/lp0). When you
turn off your laser printer, the device
(such as /dev/usb/lp0) disappears.

You connect the laser printer, turn it on,
and configure it with the CUPS Web inter-
face. It sees that your laser printer is on
/dev/usb/lp0 and saves that configuration.

Now, let’s say you turn off your laser
printer, and the /dev/usb/lp0 device disap-
pears. Go ahead. I will assume you said it
with me.

Now you connect your color printer
and turn it on. Linux sees the color printer
and creates the device /dev/usb/lp0 all
over again. The CUPS Web interface con-
figures your color printer to use the same
device as your laser printer, /dev/usb/lp0.
This is not good when you connect and
turn on both printers. One of them will
be connected as the device /dev/usb/lp1.
It is configured to be connected on
/dev/usb/lp0 and will not work.

You think this is bad enough? It is
worse. Maybe one printer is built so that
Linux keeps it connected as /dev/usb/lp1
even after you turn it off. You see, there
are many ways to confuse your server and
CUPS about your printers. Connect them
in different orders. Turn them on in differ-
ent orders. If you have plenty of time on
your hands and have a destructive per-
sonality, try all of the combinations just to
see how confused your system can get.

There are some tricks you can try to
make your system recognize the printers
correctly most often. One is to see if Linux
creates a device like /dev/usb/lp0 for at
least one of your printers when you con-
nect the USB cable while it is still turned
off. If so, then configure this printer first.
Then connect the second printer and con-
figure it using /dev/usb/lp1. This is not a
perfect solution, but it helps.

If Linux does not create a device for
either printer when they are turned off
and connected, then be sure to turn them

on in the same order every time, the
same way you turned them on when you
configured them in CUPS.

Finally, you can buy a huge uninterrupt-
ible power supply (UPS), configure your
server and your printers until they work,
and never turn anything off ever again.

There are times when CUPS provides you
a special URI name instead of the name of a
USB port. For example, it might give you the
option of configuring your HP printer to use:
usb://HP/DeskJet%203820?serial=CN55N5R55555.
It seems logical that this would solve the
problem, because CUPS could use this infor-
mation to determine the USB port that your
HP printer is using, even if it changed. This
doesn’t always work, though. After exten-
sive scientific research, I have determined
that the chance of it working has something
to do with the phase of the moon.

If you are a Linux expert, you can
teach your system to recognize a specific
printer and assign it to a specific device
when you plug it in. But if you are a Linux
expert, you don’t need my help.

I want to be fair. This problem doesn’t
exist for every distribution of Linux. It
doesn’t exist for every configuration of
Linux and/or CUPS. But for those who
have this problem, I hope this answer
helped you, whoever you are.�

I am a sweet, humble, delicate and very cute genius
who is at your service to answer your Linux ques-
tions if I so choose. Send your questions to
mango@tuxmagazine.com.
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Linux is increasingly capable of meeting all your
home computing needs, even the needs of
your household’s youngest members. As the
open-source software movement grows (and
the open-source software developers’ families
grow), the number of kid-oriented programs
increases. One of these is Tux Paint, a drawing
program with a wealth of features (and a dash
of education) to entice and engage users not
ready for the powerful but complex graphics
program, The GIMP.

Tux Paint was designed to be self-contained, so
your little ones can draw for hours without making a
mess of your files or your kitchen table (your mouse
and keyboard are another story). Tux the Penguin
guides children in your choice of more than 40 
languages, providing gentle prompts, positive feed-
back and educational tidbits. Sound effects, stamps
and a variety of “magic” effects elevate an other-
wise solid paint program into a kid magnet. And, like
any good Linux program, it’s highly configurable.

INSTALLATION
Tux Paint has been packaged for many popular
Linux distributions and is also available for Mac
OS X and Windows. Users of the Debian,
Fedora, Red Hat or Slackware Linux distributions
can download Tux Paint and use their favorite
package manager to install it. Being an open-

source project, the source code is also available
for the more ambitious user, of course. (See
http://www.newbreedsoftware.com/tuxpaint/
download for details.)

Tux Paint requires a number of support libraries:
the Simple DirectMedia Layer library (libSDL); some
SDL-based support libraries (SDL_image, SDL_ttf
and SDL_mixer); FreeType2; gettext; and libPNG.
All of these should be readily available for, if not
already installed on, your Linux system.

Once installed, you should be able to access
Tux Paint from your Start menu’s Graphics applica-
tion menu. For those who are command-line
savvy, simply type tuxpaint at a command
prompt to launch the program.

CONFIGURATION
Configuration of Tux Paint is isolated from the
program itself to keep curious little fingers from
monkeying with your carefully selected settings.
The Tux Paint Config tool requires the Fast/Light
Toolkit (FLTK), which may or may not be a sepa-
rate package, depending on your distribution. The
configuration tool is a point-and-click interface
that allows you to choose the language Tux Paint
uses, set its screen size and enable or disable
such options as sound, printing, full-screen
mode and so on. If the configuration tool
Tuxpaint-Config doesn’t show up on your

KDE/GNOME/whatever menu, start it from the
command line (or press Alt-F2 to run a com-
mand) by typing tuxpaint-config.

The number of settings may seem overwhelm-
ing, but each was added (often at the request of
parents and teachers) to meet the needs of a vari-
ety of users. By changing the options, Tux Paint can
be made appropriate for very young users, users
with learning disabilities and students in the class-
room. Tux Paint Config was designed to be as easy
on parents as Tux Paint is on kids, so each setting
option is explained and should be fairly intuitive.

Once you’ve set the options you want, simply
click Apply to save the changes, and restart Tux
Paint. The settings apply only to the current user,
so if you give each child a separate login, your
fourth grader need not be limited by the same
restrictions as your pre-schooler.

Like most programs you’ll find on Linux, you
also can specify settings when running Tux Paint
from the command line. For example, typing
tuxpaint --nosound --fullscreen runs Tux
Paint with sound disabled and in full-screen mode.

It is also possible to create a system-wide
configuration, but this requires root access and
the skills to edit a plain-text configuration file,
and is therefore somewhat beyond the scope
of this article. See Tux Paint’s documentation
for more details.

Tux Paint for Kids
Tux Paint provides mess-free creativity for your little Linux users.

BY WILLIAM KENDRICK AND MELISSA HARDENBROOK
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ADVANCED FEATURES
Anyone who ever has used a paint program will feel at home with Tux
Paint’s fundamentals. You choose a colour and one of several tools (Line
tool, Text tool, Paint tool and so forth), a brush size and shape and a
colour. You can erase mistakes with the Eraser tool, and last-minute
design changes are easy with the Undo and Redo buttons, or you can
scrap the project entirely with the New button. You can print the finished
masterpieces with a single click—unless you disable printing, of course.

There are also a number of less basic features, a few of which may not be
readily obvious, even to parents.

SHAPE TOOL
For the stickler who insists on perfect polygons, the Shape tool provides out-
lines and filled shapes like rectangles, triangles, ellipses and circles (okay, the
circles aren’t perfect). As with other tools, simply choose the shape and the

colour and click. Follow the directions Tux gives to resize and rotate the
shape (shape rotation is one of those features that you may want to disable
for younger users).

MAGIC TOOL
When you choose this tool from the menu on the left, it opens a Magic
menu on the right with a variety of special effects. Some, like Blur, Chalk
and Blocks, are artistic effects. Others, like Fill, Mirror and Flip, work
exactly like similar tools in any other paint program—fill an area with
colour, reverse the image left to right and flip the image upside-down.

Each effect is labeled clearly with the effect name and an illustrative
icon. Tux the Penguin, as usual, also provides useful instructions.

HOME PLATE
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Figure 1. Tux Paint Conifg Dialog

Figure 2. Tux Paint’s Shape Tool
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STAMP TOOL
One of Tux Paint’s best-loved features is its Stamp tool. Choosing this tool
brings up the Stamps menu on the right, and a choice of more than 200
images to paste into the drawing, just like a sticker. However, Tux Paint’s
stamps allow greater freedom than real stickers. You can reverse stamps,
flip them upside-down and make them smaller or larger. If the colour
palette at the bottom of the screen becomes active, you can change the
colour of the stamp too. For younger users, you can disable the resizing
and the reversal/flipping functions with Tux Paint Config.

Because Tux Paint stamps rely on common formats, it is possible to edit
existing stamps. Stamps are stored in the popular Portable Network Graphic
(PNG) format, which can be loaded and edited in applications like The GIMP.
Stamp sound effects, stored in WAV format, also can be edited. The descrip-

tion of the stamp and various settings (such as whether you can change the
stamp’s colour) are stored in plain-text files.

It is also possible to add entirely new stamps, though the technical details
of this are beyond the scope of this article. The more ambitious user will find
the process is covered extensively in Tux Paint’s documentation.

OPENING AND SAVING FILES
Because the typical three-year-old has neither the interest in your filesystem
nor the intellectual power to comprehend it, the process of saving, opening
and deleting files has been simplified.

Unlike most other computer programs, there is no Save As stage, that is,
Tux Paint does not ask what the file should be called or in which directory it
should be saved. When you click the Save button, Tux Paint automatically
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Figure 3. Tux Paint’s Magic Tool Figure 4. Tux Paint’s Stamp Tool
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assigns a filename to the picture and saves it in PNG format.
You can click the Open button to bring up a mini-graphical file

browser within the program. All previously saved pictures are displayed
as thumbnails (strictly sans filename). You can delete or load any file
from this browser.

Like any other file, you can access a Tux Paint picture from other pro-
grams, so you can e-mail the latest masterpiece to grandma or splice it into a
text document and send it to her the old-fashioned way. By default, Tux
Paint saves to the .tuxpaint/saved folder in the user’s home directory. If it is
prohibitively difficult to access hidden files, the default location can be
changed using Tux Paint Config.

DRAWING ON PHOTOS
It is possible to import pictures into Tux Paint, as
well. However, because Tux Paint uses a fixed canvas
size and stores its pictures in PNG format, images
first must be converted to PNG format, scaled and
cropped, and put where Tux Paint can find them.
Fortunately, there’s a tool that comes with Tux Paint
to do this for you.

The command-line tool, tuxpaint-import, takes a list
of images (which can be in almost any format) and
makes copies of them inside Tux Paint, in the appropri-
ate size and shape.

You even can do this from the file browser in
Konqueror by selecting the file(s) you want to import
into Tux Paint, right-clicking on it and selecting Open
With→Other... in the menu that pops up. Simply type
tuxpaint-import and click OK.

The next time you click the Open button in Tux
Paint, the pictures should be available. And remember,
these are copies, so your originals are safe!

THE FUTURE OF TUX PAINT AND YOU
Tux Paint’s development is ongoing, so it keeps getting
better and better. New features already have been 
created for the next release, including a number of
new Magic tools, faster startup time, support for 
larger screen sizes, an improved colour palette and
translations to six additional languages.

Tux Paint fans are encouraged to pitch in with
suggestions, bug reports, code, translations, new
stamps and so forth, on Tux Paint’s two mailing
lists—one for Tux Paint developers (technical and
code-related talk) and one for parents and teachers.
(See http://www.newbreedsoftware.com/tuxpaint/lists
for details and to subscribe.)�

HOME PLATE

21www.tuxmagazine.com

Figure 5. Open Existing Images with Tux Paint
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The hottest personal device of the season is unarguably Apple’s iPod in its various
flavors, especially now that it supports platforms other than the Macintosh. The
good news for us is that with a little work you can have your iPod working
under Linux. Your iPod acts like a removable hard disk drive under Linux, and var-
ious programs exist that support reading and writing music to and from the
iTunes database on your iPod. amaroK (http://amarok.kde.org) is a KDE media
player that has basic support in its latest version for copying music back and
forth [see Dee-Ann Leblanc’s “The Amazing amaroK: Let the Music Play” in the
March 2005 issue of TUX]. Support for rating of music, syncing and playlists is
scheduled for the upcoming 1.3 release.

You’ll need to have support for the filesystem your iPod uses in order to
get your iPod working with Linux. The most popular Linux distributions have
support for both fat32 (for Windows) and hfsplus (for Mac). The iPod behaves
exactly the same regardless of whether you use FireWire or USB to connect it
to your computer.

You will need to do a small amount of work at the command line to set
things up the first time. If you’re not comfortable with terminal windows and
command lines, find a geek (they’re everywhere) to do this part for you.
Remember, always create backups of system configuration files you may edit,
so that you can restore them in case you make a mistake.

If you plug in your iPod and you have all the correct support for USB storage
devices in your kernel, Linux should detect your iPod automatically. Chances are
Linux will have assigned the device the name /dev/sda, which means “the first
USB storage device on the system”. To check this, you need to go to the console.
Open up your favorite terminal application and type dmesg.

Have a look at the last five lines or so on your screen. You should see
something that looks a bit like this:

Attached scsi removable disk sda at scsi0, channel 0, id 0, lun 0

Attached scsi generic sg0 at scsi0, channel 0, id 0, lun 0, type 0

usb-storage: device scan complete

usb 1-1: USB disconnect, address 4

The line reading Attached scsi removable disk sda at scsi0
indicates that your iPod is device /dev/sda. If it reads sdb instead, your
iPod would be the device /dev/sdb.

Once you know what device the iPod uses, you can make an entry in your
system’s filesystem table for your iPod. The fstab file contains a listing of
both the local and the network filesystems that are regularly connected to
your computer. You need to be the root user to edit this file. There are a few
ways of doing this, either with your favorite console-based editor using su
(you will need to know the root password) or sudo. You also can use a
graphical editor and kdesu. Make a backup copy of the /etc/fstab file, and
then open up the file /etc/fstab in your favorite editor.

The line you need to add differs depending on whether you have a
Windows- or a Mac-formatted iPod.

For a Windows (fat32) iPod, add:

/dev/sda2  /mnt/ipod   vfat   noauto,user   0 0

For a Mac (hfsplus) iPod, add:

/dev/sda   /mnt/ipod   hfsplus  noauto,user   0 0

These lines give your system the information it needs to make your iPod
accessible to normal users. The first column is for the device node in the system
that represents the physical device of your iPod. The second column specifies
where it should be accessed by the user—in this case, the directory /mnt/ipod.
The third column details which filesystem type this device is. The fourth column
lets you specify options, in this case those that let unprivileged users mount and
write to the devices. The last two columns (both zeros) have to do with checking
the filesystem.

Save the file, and then create the directory to mount your iPod to as
the root user using the command:

mkdir /mnt/ipod

Your iPod has to be mounted under /mnt/ipod for amaroK to pick it up. Now
launch amaroK, and navigate to the Device browser. Here you will see your iPod’s
music collection, and you can drag music directly from your playlist window onto
the window showing your iPod’s music library to queue it for transfer. When you

iPod and Linux
Here is how to get the iPod, one of the hottest gadgets around, working with Linux.

BY JESSICA HALL
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have finished queuing tracks, click the
Transfer button to begin the transfer. To copy
music from your iPod onto your computer,
simply drag it from the window showing your
iPod’s music library onto your desktop, or any
Konqueror window showing a directory you
have the permissions to write files to.

Right-click on the desktop and select
Create New→Link to Device→Hard Disc
Device to make a shortcut for your KDE
desktop that lets you mount and unmount
your iPod easily. Give your device a name,
like iPod. On the device tab, select the
entry that you have just made in your fstab
in the drop-down box. Click OK, and the
icon will appear on your desktop. You now

should be able to mount your iPod when
you plug it in by clicking on this icon.
Always remember to unmount your iPod
before unplugging it from the computer!
This is an essential step. If you do some-
thing like delete a file from your iPod, and
then remove it without unmounting it, it’s
likely that the file is still on the iPod. So to
make sure all the changes you made take
effect, right-click on the icon for the device
and select unmount from the menu. If
you’re a command-line person, you can use
the umount /mnt/ipod command.

There are myriad other applications for
more advanced users that can help you get
the most from your iPod. Some of my

favourites are:

� gtkpod (http://gtkpod.sourceforge.net):
gtkpod allows for syncing of PIM data
and playlists with your iPod, with many
advanced features. Unfortunately, these
features have come at the price of a
less-than-intuitive interface.

� Kpod ioslave (http://kpod.sourceforge.net/
ipodslave): a KDE ioslave to enable KDE
KIO-aware applications, such as amaroK
and Konqueror, to access the music and
playlists stored on your iPod.

� SyncPOD (http://armin.emx.at/ipod):
SyncPOD is a Perl script that syncs a local
directory with your iPod.

For more information on the versatility
of iPods under Linux, try a Google search
for “iPod Linux”.�
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Figure 1. amaroK, with Media Queued for Transfer

Figure 2. The Device Tab of the Link to
Device Dialog
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We at TUX never insult our readers with name-calling like “for Dummies” or
“for the Complete Idiot”. It’s not stupid to want exact instructions the first
time you tackle something! So, we’ve knocked the most basic MEPIS install
down to 14 steps, ten of which are instructions to click on the Next→
button or the OK button.

We’ll assume you already have SimplyMEPIS 3.3 CD by download or mail-
order, and that your PC will boot from a CD. Not every PC boots from a CD
in the same way.

Booting a Live CD often just works on machines made in the last five or
six years—simply put the Live CD in the drive and turn the machine on. If it
ignores the Live CD and boots from the hard drive as usual, you can make it
do so.

One way is to change a setting in the machine’s BIOS at the startup. We
have examples from three of the most popular products:

� Award: http://www.cuug.ab.ca/branderr/mepis/bios_award.html

� Phoenix: http://www.cuug.ab.ca/branderr/mepis/bios_phoenix.html

� The new Phoenix-Award merger:
http://www.cuug.ab.ca/branderr/mepis/bios_both.html

If that doesn’t work, try pressing the Esc key right when your computer
screen lists the hard drives available during boot-up. Some computers will
pop up a menu, allowing you to boot from the CD or even from other
hard drives.

Another possibility, common on IBM desktops in recent years, is to have a

setting available for startup device without having to go into BIOS menus.
Lastly, if all else fails, your machine may need to boot from a humble floppy.

There is another wonderful free software product out there called Smart Boot
Manager. You can find it at the URL http://btmgr.sourceforge.net/about.html.
The techies and existing Linux users can read about it on that page, but for
the Windows users that are a little uncertain about booting anything but
Windows, here’s the 411 on it:

1. Download the Windows EXE file from
http://btmgr.sourceforge.net/3.7/sbminst.exe to your C:\ directory.

2. Grit your teeth and open a DOS command-line window.

3. Put a blank floppy in your A: drive.

4. Type: smbinst -d 0 (that last character is a zero).

5. It will rattle your floppy drive for a second and ask “Are you sure you
want to install Smart Boot Manager to drive 0? (y/n)”—press y and Enter.

6. About two seconds later, you’ll have your boot floppy!

Booting with this floppy in the drive quickly pops up another DOS-like
character screen that lets you press the down arrow to move through menu
choices like Quit to BIOS, Power Off, Floppy, Hard Drive and, yes, CD-ROM.
Down-arrow to that choice and press Enter, with your MEPIS CD in the CD-
ROM drive. Away you should go!

How to Install MEPIS 3.3 Simply
A step-by-step, click-by-click guide to installing MEPIS Linux to your hard drive.

BY ROY BRANDER
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PREPARATION
Put the SimplyMEPIS 3.3 Boot CD in your CD drive and power up using
one of the methods above. While you are waiting for the login screen,
you might want to find a book, magazine or something good on TV.

You’ll be needing
something to pass the
time in a few min-
utes!

When the login
screen appears (see
Figure 1), click once
on the ROOT user
name, and type root

(small letters) in as the password when the cursor jumps down to that
field. Then press Enter.

STEP 1
Moments later, the MEPIS desktop will appear with a red background to
warn you that you’re running as root. On the middle left of the screen, there
will be a hammer-and-wrench icon that says “Install Me” (see Figure 2). Click
it once.

STEP 2
This starts up a program called MEPIS OS Control Center. It includes several
utilities. The first one is Install MEPIS on the Hard Drive (see Figure 2). Click
that once.
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Figure 2. Initial Installation Screen Figure 3. Partitioning and Formatting Your Hard Drive

Figure 1. MEPIS Login Prompt
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STEP 3
Clicking that pops up only a copyright notice and makes live the Next→ but-
ton at the lower right (see Figure 2). Single-click that.

STEP 4
Now you have some options, but only if the words “Disk Partitioning” do
not fill you with fear. The default disk setup is to use your whole hard drive,
wiping out your existing OS and data. If that’s okay, just make sure you pick
the option Auto-Install Using Entire Disk, then single-click Next→ again (see
Figure 3).

If and only if you know what you are doing, you can first click on QPartEd
to use the world’s easiest disk partitioning program.

STEP 5
Promptly, you’ll see a confirmation dialog box come up. Last chance not to
wipe your hard drive. If that’s a yes...well, click on YES (see Figure 3).

STEP 6
Read your magazine. Depending on the speed of your processor, the speed
of your CD drive and the phase of the moon, it may take more than half an
hour. You can watch the progress bar, but reading is better for you (see
Figure 4).

STEP 7
Finally, it will show a dialog about Select Boot Method and something about
Installing GRUB (see Figure 5). You don’t want to know. Just hit Next→.
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Figure 4. MEPIS loads the software onto the hard drive. Figure 5. Installing the Boot Loader
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STEP 8
Next, click Yes on the confirm dialog (see Figure
5). Why they worry about overwriting the boot-up
part of your disk I don’t know—you’ve already
overwritten the rest of it.

STEP 9
After a few minutes, it had better pop up a
dialog that says “GRUB Installed OK” (see
Figure 5). If so, click OK to keep going. (If not,
you’ll have to start again and this time, use
QPartEd before formatting to delete all the 

partitions on your disk first—that generally
does the trick.)

STEP 10
Next, create at least one user account so you
don’t normally run as root. This is very impor-
tant. The root user exists to do system adminis-
tration, and that means the root user literally
can delete everything on your entire system. A
normal user account can damage only his or her
own files.

See Figure 6 for the following operations:

backspace over the suggested user name, then
put in whatever user name you want (I used
tuxmagazine). Choose and enter the same pass-
word twice. Now, choose and enter the root
password twice. Depending on how secure you
want your machine to be, you should choose
passwords that are hard to guess. Adding 
numbers and symbols to the password helps.

STEP 11
Then click Next→ (see Figure 6).
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Figure 6. Create a normal user and set the passwords for user and root. Figure 7. Setting the Network and Samba Workgroup Names
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STEP 12
See Figure 7, which involves setting up the net-
work. You should only mess with the Computer
Network Names if you understand a smidge of
Windows Networks and have Windows computers
that are sharing out disks or printers. If not, then
leave in the defaults and click only Next→.

If you don’t plan to connect this computer
to any Windows machines, click on the Samba
Server check box to UN-check it (see Figure 7).

STEP 13
On the 7a. Services to Start dialog, you’re 
fine to click Next→ again. But if you have 
cable or ADSL and never use a modem, you
might as well un-check the PPP Service. 
Un-check the firewall service only if you know
a lot about security and are certain you don’t
need it!

STEP 14
When you see the “do you want to reboot
now?” dialog come up (see Figure 9), you’re
done. Simply click on YES, and start pressing
the front button on your CD drive so that it
pops out the CD once the system finishes its
shutdown and starts the reboot. You of course
want to see if it boots from the hard drive.
Time to pop open a drink!�
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Figure 8. Services to Start Figure 9. Reboot to Start Up MEPIS
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With MEPIS installed, your boot from hard
drive should show you a login screen that
now gives you your own chosen account
name as well as root, rather than the
demo account of the Live CD. Having
logged in to your own account, your MEPIS
desktop is a basic KDE 3.3 desktop (or 3.4
by the time you read this) with a number
of good programs pre-installed.

You can browse through these on your own
by starting from the KDE Start menu, which
exactly like the Windows menus of the last
ten years, begins with a click on the lower-
leftmost point on the screen, the KDE K on
top of a sprocket icon.

There’s one chore to do that MEPIS can’t
do for you because of certain legal uncer-
tainties. Authorities around the world have
given up attempting to halt the spread of
Jon Johansen’s libdvdcss2 package that
allows Linux users to view their own DVDs.
And we assume you feel little guilt over
the “crime” of viewing your own DVDs. But
because of the controversy, his libdvdcss2
package is not pre-installed. They have
made it very, very easy to install, however.

Clicking on the KDE Start menu, pick the
System submenu and find Synaptic Package
Manager on that. It will first pop up a dia-
log to ask you the root password, which is
needed for software installs.

Then the main Synaptic program comes up,

showing the start of the enormous list
(tens of thousands) of free program pack-
ages available to you. At the top right, a
Search button is your next click. That pops
up a little dialog with the cursor in the
search term field. Simply type, exactly:

libdvdcss2

and then press Enter.

It won’t take a moment for the package to
be the only one listed—or possibly a few
versions; there is usually a new one in devel-
opment. But it will be the base standard
package already checked for installation. If
you’ve found it, and it’s been checked auto-
matically, the Apply button will be highlight-
ed, and you need only to click that to start
the install.

With some packages, directions will come up,
perhaps ask you questions about prefer-
ences—but not with this small, simple pro-
gram. Your only instruction, moments later,
will be to close the black terminal window
that has popped up to show you the automat-
ic install commands running.

To see if it worked, pop a commercial DVD in
your DVD-ROM drive, and then use the K Start
menu to find the Multimedia menu and pick
Xine off that. Xine comes up as an empty win-
dow with no controls—you have to press the
G key on your keyboard to pop up the control
panel. Along the bottom are several buttons

showing things it can play, like CD, VCD and
DVD. Click the DVD button to play your DVD.
While it’s playing, you can leave it in the win-
dow, or press your F key to make it full
screen—then use the G key to pop up or
down the control panel as needed. [See Lew
Pitcher’s “Movies and More—Life with Xine”
in the May 2005 issue of TUX for more on
using Xine.]

Depending on your system, you may have other
setup jobs to do. Note that there are two con-
trol centre programs for setting up the system.
The one called OS Control Centre on the System
menu is only for hardware-level settings like
the network card and video card settings. You’ll
be asked for the root password again to run it.
The one simply called Control Centre on the
same menu is the user-level control program for
the KDE desktop and services. This includes a
wizard for setting up your printer, from Printers
on the Peripherals menu, and managing the
user accounts on the machine from Password
and User Account under the Security and
Privacy menu. The Peripherals menu also has a
wizard to set up your digital camera—but not
your scanner. For your scanner, you need to
start Kooka from the Graphics submenu of the
K menu, then pick Select Scan Device from its
Settings menu.

After that, enjoying MEPIS is a fun game of
“what’s this menu button do?” Try out all the
dozens of programs it comes with and learn
your way around.

Roy Brander is a
waterworks engineer
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manager. He chairs
the Calgary Unix
Users Group, which
provides meetings
and an Internet forum
for the UNIX commu-
nity in Calgary, Canada.
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defense community
on Risk Management
and the Titanic disaster;
materials are now avail-
able at his Web site:
http://www.cuug.ab.ca/
branderr.
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These days I struggle to find space for all the information I accumulate. If
you are anything like me, your computer is a veritable treasure chest filled
with old projects, digital camera photos and other assorted eccentricities.
When you tire of mediating territorial disputes between office documents
and MP3s, it is time to call upon K3b—paragon of effortless burning. With
K3b at your command, burning a CD is as easy as burning dinner.

K3b leverages the power of numerous command-line burning systems,
integrating the best of them with its flexible and intuitive user interface.
The simplicity of K3b enables users to take advantage of its broad array of
versatile features with relative ease. With its powerful plugin system,
effective media encoding features and support for a wide variety of CD
and DVD formats and operations, K3b is the uncontested champion of
Linux disc burning. In this article we explore its features and capabilities as
I demonstrate its use.

CONFIGURATION
Linux configuration may seem more like an art than a science to those
with little exposure to the craft. Typically, setting up a system to burn
CDs requires one to invoke the obfuscated arcanum of paths, programs,
permissions and other assorted obscurata. Fear not; K3b is the solution
to all your burning desires. Not only is it free (and it comes with KDE),
but you need not be a sage or sorcerer to employ it. K3b is equipped
with a number of impressive features that automate a majority of the
necessary configuration tasks. When you start K3b, it attempts to identi-
fy your hardware and locate the utilities it needs. K3b has been able to
autoconfigure itself correctly on almost every system I ever have tried it
on. If it does run into problems, K3b presents you with a simple dialog

that explains each problem and offers solutions.
K3b comes with a utility called K3bSetup (Figure 1) that can help resolve

many common configuration problems. If K3b claims that it cannot find a

K3b, and Feel the Burn
Many tools for creating (burning) writable CDs are unintuitive at best, ignorant
and difficult to configure at worst. Fear not. K3b is here to come to the rescue.
Ryan Paul explains the basics about how you can easily configure and use K3b
for your CD-burning pleasure.

BY RYAN PAUL

Figure 1. K3bSetup
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utility that you know you have installed (Figure 2),
you might want to try using K3bSetup to ensure
that the directory containing the utility in question
appears in the program search path list (Figure 3).
K3bSetup also helps you automatically configure
the permissions of the burning devices and
required utilities. By default, K3bSetup provides
full access to the selected devices to the root user
and the user that started the setup process. If
multiple users on your system want to be able to
use K3b, you should use the burning group

option. If you use a burning group, you will be
able to provide a user with full access to the
selected devices simply by adding that user to the
specified group.

If all the drives are detected correctly, K3b may
ask you to specify the write speed of your devices
(Figure 4). The read/write speeds usually appear
on the front of the drive bay door, but you may
want to refer to the documentation that came
with your drive. You can check for configuration
problems by selecting System Check from the
Help menu, and you can start the K3bSetup utility
at any time by selecting K3b Setup from the
Settings menu or by executing k3bsetup from the
command line.

Figure 4. Write Speed Verification

THE OPTIONS DIALOG
The K3b Options dialog (Figure 5) allows you to
fine-tune your configuration, customize the inter-
face and retrieve information about detected opti-
cal drives. You can open the Options dialog by
selecting Configure K3b from the Settings menu.

The Programs option module provides you with
a great deal of useful information. It lists the ver-
sion number, associated features and full path of
every single tool utilized by K3b. The User
Parameters tab of the Programs option module

allows the user to specify custom arguments for
the individual utilities. The Programs option mod-
ule also provides the user with an interface for
customizing the application search path. The
Plugins option module allows the user to config-
ure the media plugins available to K3b.

THE INTERFACE
The K3b interface (Figure 6) contains the file man-
agement pane and the project workspace pane.
The file management pane is vertically split. The
left side of the file management pane contains a
directory tree that allows you to navigate through
your filesystem directory structure easily. The right
side of the file management pane contains a view
of the contents in the currently selected directory.
Beneath the directory listing there is a small tool-
bar with navigational buttons that behave much
like the navigation toolbar buttons in Konqueror.

The bottom pane is the project workspace.
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Figure 2. K3b Problem Dialog

Figure 3. K3b Search Path

Figure 5. K3b Options Dialog
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When there are no
active projects, K3b dis-
plays action buttons in
the project workspace.
These action buttons
are convenient short-
cuts that you can use
to start projects or uti-
lize specific K3b fea-
tures. You can add
action buttons to the
workspace field by
right-clicking within the
field and selecting the
action for which you
would like to add a
button. To remove an
action button, right-
click it and select
Remove Button from
the context menu.

You can start a new project by selecting New Project from the File menu
and then selecting the specific type of project from the New Project sub-
menu. When you start or open a project, it appears as a tab within the proj-
ect workspace. When you have multiple projects open simultaneously, you
can switch to a project by selecting its tab. To close a project, right-click its
tab, and select Close from the context menu.

BURNING A DATA CD
Data CDs store files and folders. You can treat them like hard drives that can
be written to only once. After a data CD has been burned, you can access
and copy the files on the disk, but you can’t change them or delete them.
Data CDs can help you preserve important content without wasting your
hard drive space. Data CDs are perfect for archiving old office documents
and storing digital camera pictures.

Data project tabs are split vertically, much like the file management pane
(Figure 7). The left side contains the project’s directory structure, and the
right side contains the contents of the current project directory. You can add

files and folders to the project by dragging them from the file management
pane (or a Konqueror window) into either pane in the data project tab. You
can create new folders within the project by right-clicking in either of the
two panes in the project tab and selecting New Directory from the context
menu. You can remove a file or folder by right-clicking it and selecting
remove from the context menu.

The horizontal bar at the bottom of the project tab lets you assess the
size of your project. The number toward the left side of the bar is the
current size of your project in megabytes. Toward the right, you will see
grey text that provides you with a ratio comparing how much space you
have left in the project with how much total space the project can use.
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Figure 6. K3b Interface

Figure 7. Data Project Tab

Figure 8. The bar shows how much space you have for your project.
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The maximum project size is determined by the
media you want to burn to. Most CDs can
store about 700MB in data mode. You will also
notice that as you add files and folders to the
project, the bar starts to fill with green (Figure
8). Toward the right end of the bar, you will
notice a single vertical line that is about half as
tall as the bar. When the green meter reaches
that line, the project is full. If you continue to
add files at that point, the bar will fill with red
beyond that point, indicating that you have
exceeded the maximum allowable space for 
the project. When you exceed the maximum
allowable space, you have to remove files from
your project until it fits before you can burn it
to a CD.

When your project is ready, put a blank CD
into your drive and click the Burn button to open
the data project burn dialog (Figure 9). The burn
dialog allows you to set some project-specific set-

tings before the starting the burn. Make sure that
the Burning Device drop-down is set to the correct
optical drive.

Take a look at the check boxes on the right
side of the Writing tab. If Simulate is checked,
K3b goes through all the steps required to per-
form the burn, but it doesn’t actually burn any-
thing to the CD. You can use this option to test
your configuration without having to waste a CD.
When On the fly is checked, K3b does not con-
struct an independent disk image before burning;
it burns directly to the CD. Constructing a disk
image takes time and disk space, so I generally
use the On the fly option. The Burnfree option
helps prevent buffer underrun errors. Those who
already have some experience with CD burning

know that burners can be fickle. Any number of
things can cause a burner to choke and produce a
dead CD (which isn’t necessarily bad if you need a
coaster, but it’s not exactly conducive to reliable
data storage). Enabling Burnfree buffer underrun
protection decreases the number of potential
burning failures. I highly recommend using the
Burnfree option.

When Only create image is checked, K3b
creates a disk image using the filename speci-
fied in the box to the right of the Options
check boxes. A disk image is a single file that
contains the contents of the CD. A disk image
easily can be burned to CD with K3b’s image
burning feature. Disk images often are used to
distribute the contents of CDs on the Internet.
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Figure 9. Data Project Burn Dialog

Figure 10. Burn Process Dialog Figure 11. Data Burn Completed
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The Verify written data check box
uses checksums to verify that the
contents on the CD match the con-
tents of the project once the burn
has been completed. It is probably a
good idea to use this feature, but
I’m an impatient sort of guy and I
typically only use this feature when
I’m burning something irreplaceable.

When you are satisfied with the
configuration, click the Burn but-
ton in the burn dialog to start the
burning process. When K3b starts
burning, it opens the burn progress
dialog, which allows you to see the
progress of the burn, the current
write speed, the elapsed time and
the buffer status (Figure 10).

Information about the burn
process appears in the list box above
the progress bars. If the burn
process completes successfully, the

word Success! appears in green
right above the elapsed time display,
and a Close button appears at the
bottom of the dialog (Figure 11).
Click the Close button to return 
to the K3b interface. Your CD is
now ready!

BURNING AN AUDIO CD
Audio CDs contain music exclusively
and can be played in most audio CD
players. K3b uses its encoding plug-
ins to convert your audio files into
the necessary format automatically
before burning.

Audio CD projects are very simi-
lar to data CD projects. Drag
music files from the file manager
pane to the project tab to add
them to the project. If you drag a
directory into the project tab, K3b
adds all the audio files in the

directory to the project.
When the project is burned, the

individual files become audio
tracks on the CD. You can change
the order of the tracks by drag-
ging the files up or down inside of

the project. To change the meta-
data of the track, right-click the
track, and select Properties from
the context menu.

The size of an audio CD project is
measured in time rather than in
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Figure 12. The bar indicates how much available time the project is using. Figure 13. Audio CD Burning
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megabytes. Most CDs can store up to
about 80 minutes in audio mode. The
project size gauge works the same way
in data and audio projects. As you add
songs, the bar fills with green, indicat-
ing how much of the available time the
project currently uses (Figure 12).

When your audio CD project is ready,
click the Burn button to open the audio

project burn
dialog. The
options in the
audio project
burn dialog
are very similar
to the options
in the data
project burn
dialog. You
will notice that
the audio proj-
ect burn dia-
log has a CD-
Text tab,
which can be
used to cus-
tomize CD
meta-data.

When you
are satisfied
with your
configuration,
click the Burn
button in the
audio project
burn dialog
to start the

burning process. The audio CD burning
process is exactly like the data CD
burning process (Figure 13). When the
burn process completes, you can click
the Close button to return to the K3b
interface.

BURNING AN ISO DISK IMAGE
An ISO image is a complete CD in the

form of a file. For example, you can
download a Linux distribution that nor-
mally would come on three CDs by
downloading the three ISO image files
off the Internet and burning them to
writable CDs.

K3b makes it easy for you to burn
an ISO file to CD. Select CD from the
Tools menu, and then select the Burn
CD Image item from the sub-menu.
When the Burn CD Image dialog
appears (Figure 14), click the button to
the right of the Image to Burn text box.
Select the ISO file you want to burn,
then click the Start button to start the
burn process.

EPILOGUE
So ends our tour of K3b. This introduc-
tory tutorial should be enough to get
you up and running (up and burning,
actually), but it is far from a compre-
hensive guide. A number of other 
useful features are certainly worth
exploring. K3b is fully capable of 
producing multisession CDs, mixed
data/audio mode CDs and video CDs.
K3b also works very well with CDRWs
and DVDs.

K3b is distributed under a GPL
license and can be acquired at no cost
from the K3b Web site. Binary pack-
ages are available for most major Linux
distributions, and a port is available for
FreeBSD. For downloads and more
information, please see the K3b Web
site: http://www.k3b.org.�
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Ryan Paul is a systems
administrator, a freelance
writer and an ardent propo-
nent of open-source tech-
nology. He welcomes your
questions and comments.
Ryan can be contacted at
segphault@sbcglobal.net.

Figure 14. Burn CD Image Dialog
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One way to teach yourself The GIMP is to scan
the abundant texts on Photoshop. Although the
features in each program vary in detail, they work
in basically the same manner overall. What you
have to learn with The GIMP is how to do the
technique if the tool referenced in the Photoshop
text isn’t available.

One effect you’ll find covered in many of the
books on Photoshop is metallic finishes. This
effect is most often used on text but also can be
used with user-interface design or as textures.

All metallic finishes have at their core the use
of the Curves dialog. Adjustments to the Curves
for a gradient fill or smooth texture causes grad-
ual changes in tone to become more dramatic.
The result can be to produce the appearance of
shiny metal.

In this article, we look at creating metal effects
using The GIMP’s built-in Logos and then dig
deeper into creating the same effects manually to
add a personal touch.

THE SIMPLE PLAN
The GIMP has two built-in metal text plugins:
Chrome (Xtns→Script Fu→Logos→Chrome) and
Cool Metal (Xtns→Script Fu→Logos→Cool Metal).
As with all logo plugins, these are extremely easy
to use. Each offers the user options for color,

background and font and will generate a new and
appropriately sized image window to hold the
text. Although useful for quick-and-dirty projects, their end results are modest at best.

Chrome and Metal Text Effects
We’ve taken a tour around The GIMP and passed along some hot tips, but now
it’s time to get down to brass tacks—or rather, metal tacks. Grab a clean towel
and some polish because this month were going to brush up some cool text.

BY MICHAEL J. HAMMEL

Figure 1. Open the Chrome dialog and choose a font.
The default font may not be installed on your sys-
tem, but the Script Fu Font Selection dialog will list
only those fonts that are installed. No other options
need to be changed, though the effect may be easier
to see if the background is black instead of gray.
Click on the OK button. That’s all there is to it.

Figure 2. The Cool Metal dialog is similar to the
Chrome dialog with the addition of the background
color option. The text is rendered with a gradient
to simulate the metal effect. The result is different
from Chrome, but neither is particularly metallic.
Both plugins leave layers intact in the new image,
allowing you to modify the results as you see fit.
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GOING IT ALONE
The problem with the built-in metallic logos is that
their effects are rather static. You can change col-
ors, gradients, backgrounds and fonts, but in the
end, all of their renderings start to look the same.

They all lack the reflective nature of shiny metal.
The reason for this is that neither logo script uses
variations in tone. The color of the text is defined
either by a distinct color (with a single tone) or a
gradient applied top to bottom with only horizon-
tal variations in tone.

So, let’s see how to do this manually. I start
with the most simplistic metallic finish, Brushed
Metal (Figures 3–6).
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Figure 3. Open a new image window using the
640x480 template. Fill the background with black.
Click on the Text tool in the toolbox, then click on
the background layer. In the Text Editor dialog,
type in the letter S. Open the Text dialog
(File→Dialogs→Text) and choose an appropriate
font—I’ve used a font called 1979 as the font for
this example. This font is thick enough to show the
brushed metal texture, which is subtle and can be
lost on thinner lettering. Choose an appropriate
size as well—this example set the size to 400.
Change the text color to white. Drag the Text dialog
to the dock at the bottom of the Toolbox if you’d
like to keep it handy (which you probably will for
the rest of this tutorial). Using the Move tool, visu-
ally align the text layer with the background.

Figure 4. Duplicate the text layer. Blur the dupli-
cate layer by 10 pixels. Click on the original text
layer to make it the active layer. Open the Bump
Map dialog (Filters→Map→Bump Map). Use a
sinusodal mapping and the blurred layer as the
bump map layer. Adjust the Azimuth so the pre-
view shows light shining from the upper right.
Adjust the Elevation and Depth so the bump map
is smooth but not flat. Leave the other options
alone. Turn off the visibility of the blur layer.

Figure 5. Turn on Keep Transparency for the bump
mapped layer. Open the Gaussian Blur RLE dialog
(Filters→Blur→Gaussian Blur RLE) and blur both
horizontally and vertically by 10 pixels. Duplicate
this layer. With the duplicate layer active, select
the text (Layer→Transparency→Alpha to
Selection). Choose the Gradient tool from the
Toolbox and open the Gradient dialog. Set the
Gradient’s blend mode to Overlay. Drag from the
upper left to lower right in the image window.
Repeat from lower left to upper right, at less of an
angle (more vertical). Set this layer’s blend mode
to Soft Light.
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HEAVY METAL
The brushed metal effect you’ve just seen is the
result of two basic processes. The first is the use
of a motion-blurred noise layer. Noise layers often
are used to add texture to otherwise flat-toned
images.

The second process is the use of the Curves
dialog to adjust gray tones in an image. Adjusting
the Value curve in an image with variations that
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Figure 6. Merge the gradient layer and the bump
mapped layer. Open the Curves dialog and adjust
the curves to look something like what is shown
here. The actual setting will vary depending on
the variation in gray tones in your layer. Select the
letter (Layer→Transparency→Alpha to Selection)
and duplicate the layer. Fill this layer and selec-
tion with noise (Filters→Noise→Noisify). Disable
the Independent toggle button and move the Red
slider to 0.44. With the selection still in place,
motion-blur the layer (Filters→Blur→Motion Blur)
at an angle of 45 degrees with a length of 20. Add
a new layer. Fill it with blue (#103B82) and set the
layer blend mode to Soft Light. Reduce the opacity
to 52%.

Figure 7. Like the Brushed Metal tutorial, start with
a new image window using the 640x480 template
and fill the background with black. Select the Text
tool, click on the background layer, and in the Text
Editor dialog, type the word Metal. Choose a font
from the Text dialog. This tutorial is using Penyae
Ultra-Light, which is a font that uses uppercase
shapes for lowercase letters. You should choose a
font that is solid (no outlined fonts) and has thick
letters. The bold version of a font that has thin let-
ters might work best. Change the text color to
white. Use the Move tool to align the text layer
visually with the background. If the letters are
aligned against the edges of the layer, resize the
layer boundary to the image size (Layer→Layer to
Image Size) so that blurring won’t be cut off at the
layer edge. Select the text in this layer using Alpha
to Selection. Grow the selection (Select→Grow) by
6 pixels. Save the selection to a channel
(Select→Save to Channel). Be sure to click on the
text layer again in the Layers dialog to make it
active after saving your selection to a channel.

Figure 8. Duplicate the text layer and Gaussian
Blur it by 10 pixels. Click on the original text layer
to make it the active layer. Open the Bump Map fil-
ter again and apply it to the text layer using the
blurred duplicate layer. Turn off the visibility of the
blurred layer. Duplicate the the bump mapped
layer. Select the text by using Alpha to Selection
from the Layer menu. Fill the selection with a
cloud rendered from the Solid Noise filter
(Filters→Render→Clouds→Solid Noise). Use a
random seed and set the Turbulent toggle button.
Set the X size to 10 and the Y size to 2. Motion-blur
this layer (with the selection still active) by setting
the angle to 95 degrees and the length to 20. Set
the blend mode of this layer to Overlay. Merge this
layer with the original bump mapped layer.
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are not linear—that is, the gray is somewhat ran-
domly distributed about the layer—reduces the
smooth changes in tone so that changes from
black to white are not gradual but fast. This is the
key to reflective metals like chrome.

Next, I show you how to use the Curves
adjustments to an extreme over a layer of ren-
dered clouds to produce an even more dramatic
metallic effect (Figures 7–10).

LIQUID METAL
As you can see, the use of Curves made all the

difference in the last tutorial. You might wonder
where you can go from there—what else can you
do with metal text? In this next tutorial, I show
you how to take the last idea one final step and
add non-text components to your image (Figures
11–13).

This final version could be improved upon even
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Figure 9. Open the Curves dialog and apply some-
thing like the curve shown in this picture. This
will produce the basic metallic effect, but we want
to enhance it a bit. Add a Drop Shadow (Script-
Fu→Shadow→Drop Shadow) that is white (not
black, which is the default). Set the X and Y off-
sets to -2, which moves the shadow up and to the
left, and the blur radius to 10. The shadow is
adding depth to the lit edges of the metallic fin-
ish—that is, simulated lighting is shining from
the upper-left corner.

Figure 10. Add a new layer above the bump
mapped layer. Open the Channels dialog and click
on the channel name for the saved selection.
Select Channel to Selection to retrieve the selec-
tion. Click on the new layer in the Layers dialog to
make it active again. Set the foreground color to
gray (#a4a4a4). Open the Stroke Selection dialog
(Edit→Stroke Selection) and set the stroke width to 1.
Turn off the selection (Ctrl-Shift-A or Select→None).
Offset this layer (Layer→Transform→Offset) by 2
pixels in both the X and Y direction. Add a new layer
and fill it with blue (#103B82). Set the layer blend
mode for this blue layer to Soft Light. Reduce the
opacity to 53%.

Figure 11. As before, start with generic text. This
one uses Arial Black text. The block dots for the
letter i are desirable—we want to create our own
blobs here in a moment. Make sure the layer
boundary is expanded to the image window size
and center the layer manually with the Move tool.
Using the Oval and FreeSelect tools (highlighted
in the Toolbox in this image), draw a round blob
beneath the first i. Holding down the Shift key
draw more blobs beneath the text. The Shift key
allows you to add to the current selection even if
the new selection does not physically touch the
existing selection. Make sure the blobs overlap
parts of each letter, especially the squared bot-
toms of each i. After you have a few blobs drawn,
grow them by 1 (Select→Grow, which softens the
edges of the free-hand selections) and fill with
white by dragging the background icon into the
image window. Deselect the blobs (Select→None).
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more by taking finer-grain control of the distortion
of the text. This could be done by using the iWarp
filter instead of the Waves filter, for example.
Additional color could be added as well. Try
adding a red layer and a yellow layer with Solid
Noise layer masks to simulate hot metal at the top
of the letters—there must be some reason why the
metal is liquid, right?

You see, with The GIMP, there is a never-ending
series of better ways to do everything!�
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Figure 12. Open the Waves filter
(Filters→Distorts→Waves). Set Amplitude to 6,
Phase to 107 and Wavelength to 29. Click on OK.
The text and blobs will be distorted in a wavy
fashion—the effect depends on what font you
chose for this tutorial. Duplicate the layer.
Gaussian (RLE) Blur by 10 pixels. Bump Map the
original layer using the blurred layer, just as
we’ve done previously. Turn of the visibility of
the blurred layer. Click on the bump mapped
layer to make it active. Duplicate this layer. Select
the text and blobs with Alpha to Selection. Fill
the duplicate layer with Solid Noise as in the
previous tutorial. Motion-blur the selection at 
95 degrees with a length of 20. Set the layer
blend mode to overlay and merge with the original
text/blob layer.

Figure 13. Turn off the selection if it’s still enabled. Open the Curves dialog and adjust the
Value curve similar to what was used in the previous tutorial. If you saved the curve from that
tutorial, you simply can reload it here. Add a new layer, fill it with blue again and set the layer
blend mode to Soft Light.

Michael J. Hammel is an author, graphic artist, Web
designer and software developer currently working
for RLXTechnologies in Houston, Texas. He has spo-
ken at the ALS, LinuxWorld and SXSW conferences,
and chaired multiple conferences on Linux in
Colorado. He is the primary maintainer for the
MiniMyth build system, and he runs XEUS, his own
development site for XNotesPlus, Ximba Radio and
other open-source software. He can be reached at
mjhammel@graphics-muse.org, and his blog is at
http://www.ximba.org/wordpress.
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One of the biggest-claimed obstacles slowing the
adoption of Linux on the desktop of small and
medium enterprises (SMEs) is the lack of certain
types of software, generally financial and account-
ing software. Although OpenOffice.org provides
an office suite and Evolution an e-mail and con-
tact manager, an accounting package such as
QuickBooks is what many businesses are looking
for. Now, there is a viable alternative to
QuickBooks: the Quasar Accounting program
from LinuxCanada. Like many packages, Quasar is
available for free under the GNU Public License
(GPL) or under a commercial license. This review
concentrates on the GPL version.

FIRST LOOK: QUASAR ACCOUNTING
Quasar provides the accounting services that any
SME will need. It includes the functionality expect-
ed in any general ledger. The package facilitates
the creation of a complete chart of accounts to
track exactly where the money goes. This chart
provides a well-developed way to track expenses
and pay invoices, to record income and provide
credit terms. Additionally, even the free version of
Quasar provides advanced inventory controls that
are found only in the Premier version of
QuickBooks. Finally, Quasar’s secure handling of
multiple users, multiple stores and multiple com-
panies rounds out the complete level of control
over your business.

Quasar comes in the form
of three install packages: a
translation library, a server
and a client. The server sup-
ports only Linux and requires
a database. (Luckily, all mod-
ern Linux distributions include
the PostgreSQL database as
part of the distribution, so
this is not an issue.) The
client supports Linux as well
as Windows. This provides an
added benefit for businesses
who want to begin using
Linux but still have an invest-
ment in their Windows desk-
tops. Luckily, LinuxCanada
provides precompiled pack-
ages for most modern Linux
distributions as well as an
extremely thorough installa-
tion manual. These two items
greatly simplify installation.

QUASAR INSTALLATION AND SETUP
Installation of Quasar was easy. I simply down-
loaded the Quasar server, client and icu packages
for Red Hat Enterprise Linux 3 and ran the pack-
age manager to install the application. After
installation, I followed the very thorough database

setup instructions provided in the Quasar
Installation Guide, and Quasar was ready to use.

Quasar provides a setup program to run after
installation and database configuration. This utility
program is used to create new companies and
perform other administrative tasks. After a new
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Quasar Accounting
Have your cake and eat it too: Quasar Accounting offers free accounting on Linux and Windows.
REVIEWED BY JOSHUA BENTHAM

Quasar Accounting’s main screen provides easy
access to all of its features.
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company is set up, it is helpful to import a basic
chart of accounts provided by LinuxCanada. For
those who are new to accounting or are using
Quasar for a new company, this generic chart is
extremely helpful in setting up the system. This
chart provides common expense accounts, general
receivable and payable accounts, liabilities and
many others. Alternately, the setup utility allows
the import of data from a program currently in
use when the data is supplied in XML format as
described in the Quasar User Guide.

USING QUASAR
The intelligent design of Quasar’s user interface
allows for quick-and-easy data entry. Some programs
you may encounter are not optimized for keyboard
use. These programs require you to move your hand
to the mouse to select frequently needed options.
Although some of Quasar’s menu options are
mouse-accessible only, the bulk of Quasar’s user
interface is designed in such a way that you can
keep your hands on the keyboard by using special
shortcuts. This allows for faster data entry, which can
save time (and therefore money) in the long run.

Reporting is another one of Quasar’s strengths.
LinuxCanada provides 48 built-in reports that
cover everything from general ledger to the key-
tops of popular point-of-sale terminals. Like the
menu layouts, these reports are controlled by XML
files. This allows for the ability to customize the
reports and add things like company information
and logos. Additionally, you can create new
reports by copying the existing templates and cus-
tomizing to taste. (It would be helpful to have
some documentation on the XML format used by
the report generator. Currently, one needs to look
at one of the current reports to figure out how to
create a new one.)

QUASAR ACCOUNTING
Quasar is optimized for use in a retail environment.
LinuxCanada has a point-of-sale module available
under a commercial license. Unlike the GPL version of
Quasar Accounting, the point-of-sale module’s server
and client modules are priced separately. The prices
for Quasar point-of-sale modules are well below com-
peting products, and therefore even the commercial
versions of Quasar provide an excellent value.

All versions of Quasar offer comprehensive
inventory controls. In its most basic use, the inven-
tory module allows a business owner to track the
locations and quantities of all inventory items.
Additionally, the inventory capabilities go beyond
simple record keeping. Manufacturers and whole-
salers can assemble kits using component items;
whenever a kit is assembled, the inventory repre-
senting its component items are adjusted accord-
ingly. You can generate vendor purchase orders
for items whose quantity are below a preset level.
You can set costs and selling prices for items and
discount them in a myriad of different ways. You
can control margins and get reports on them.
Finally, you can generate reports to show such
things as profits and sales per item.

Quasar is also strong in sales and purchasing.
You easily can convert customer quotes to invoic-
es to be paid. You can create promotions and dis-
counts, and base them on date, customer or store
location. Likewise, you can create a purchase
order and convert it to a vendor invoice, which
can be paid in a number of different ways, includ-
ing printing a check. Quasar can keep track of
miscellaneous fees such as container deposits,
freight charges and franchise fees.

Quasar has many more features than I have
space to describe here. LinuxCanada has a com-
plete feature list in the Quasar download section.

CONCLUSION
Quasar’s capability is evident in the way it is
used to handle high volumes of point-of-sale
transactions. Brad Pepers of LinuxCanada gave
the following example of a client who is happy
with Quasar:

We have a customer using Quasar with Sybase and

they have three grocery point-of-sale lanes, one con-

venience store POS, one fast-food POS, a receiver’s

station, a grocery manager’s station, a dry-goods

manager station, two office POSes, one office work-

station, and the manager’s workstation and a work-

station in the convenience store. This is a cooperative

in a northern community, so they do a little of every-

thing (grocery, hardware, dry goods, convenience

store, fast-food store, gas, bar and the office acts like

the local bank as well). So that works out to 12 users,

of which the point of sale ones are very heavily used,

and this is run on what is basically a desktop-level

machine these days (I think it’s a Compaq with 1.5GB

of RAM and simple IDE drives and nothing fancy).

Quasar Accounting is a comprehensive account-
ing package providing a rich variety of complete
functionality for the small- and medium-sized busi-
ness market. At a price of zero—arguably, even at
the retail price of $149—it provides an excellent
value. It is the ideal solution for those who are
considering switching to Linux on the desktop.�

Joshua Bentham plans to graduate
soon from Capital University in Bexley,
Ohio with a BA in Philosophy. He has
been using Linux since kernel version
1.2.8. His Weblog can be found at
http://www.globalherald.net/jb, and he
can be reached at jb42@globalherald.net.
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THE SUB-$500 LINUX LAPTOP
Linspire has been doing its best to
bring Linux to the masses, creating
a version of the operating system
that’s easier than ever to use.
During the show, Linspire noted
that version 5.0 of its operating
system was right around the
corner—probably out as
you’re reading
this—and
would make
adopting Linux
easier than ever.

If that wasn’t enough, the
company has partnered with retail behe-
moth Wal-Mart to offer a sub-$500 Linux-based
notebook, marketed under the Balance brand
name. The notebook will come with a 14.1-inch
full-colour LCD display, 30GB hard drive, 128MB
of RAM (expandable to 512MB) and will be pow-
ered by a 1GHz via C3 processor. The machine will
have four USB 2.0 ports and onboard Ethernet.

Hardware is only of so much use if you don’t
have the software to back it up, though. The
notebook will come with Linspire 4.5 preloaded,
as well as the OpenOffice.org office suite, which is

on par with all but the most recent
version of Microsoft Office. It also
comes pre-loaded with all of the
goodies needed to get onto the
Internet, including messaging pro-
grams, Web browser and e-mail soft-
ware, spam-blocking software and a
software firewall. For utter beginners,
there are also a number of voice-guided
tutorials to help users get the feel for
their new Linux system.

The notebook, available for $498, can
be purchased on-line by going to Wal-

Mart’s site (http://www.walmart.com) or
Linspire’s own site (http://www.linspire.com/498).

MULTIMEDIA, MULTIFUNCTION
Portable multimedia is all the rage these days. The
Windows-centric Portable Media Centre started
the ball rolling, but other companies soon fol-
lowed suit; now there’s a growing number of
portable players that handle digital audio, display
digital photos and play back digital video files. The
30GB Archos Pocket Media Assistant 430 is a
portable media player with a twist: it also runs
Linux applications.

The player’s main purpose, of course, is to play

back media files. It even comes with a multimedia
base that allows video and television input. Users
can set the PMA430 to record live television
streams at a pre-programmed time, making it into
a tiny personal video recorder that can be taken
on the road between recordings.

You also can load Linux applications onto the
PMA430, making it into a productivity tool too.
The player’s screen is touch-sensitive, allowing
users to interact with it using a stylus. The
PMA430 has built-in Wi-Fi networking, allowing
users to connect to the Internet while on the go.

Gadget Guy—CES 2005 Edition
REVIEWED BY SEAN CARRUTHERS

The Consumer Electronics Show, held annually right at the beginning of January in Las Vegas, is a wonderland of treats for the gadget fanatic.
This year’s show had it all: cheap laptops, large-screen TVs, Internet-connected appliances and dancing robots—that’s right, dancing robots.

Although the show isn’t a computer exhibition, per se, there still were quite a few computer-related gadgets on the show floor, includ-
ing some with a Linux connection. I got a chance to take a look at a ton of products while I was at the show.
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The unit even comes preloaded with an e-mail
application and the Opera Web browser. The
PMA430 also functions as a USB host, allowing
users to attach external drives, digital cameras,
keyboards and more.

The PMA430 will have a $799 price tag.

BIGGEST! TV! EVER!
If you’re looking for a brand-new monitor that will
double as a big-screen TV, why not check out
Samsung’s new 102-inch plasma screen? That’s
right, it’s 102 inches diagonally, which works out
to about eight and a half feet. The screen has a
resolution of 1920x1080, for full-on 1080P High
Definition TV display potential. Granted, the new
102-inch model is so far only a proof of con-
cept—Samsung had the 102-inch plasma screen
at the company’s booth, but don’t expect to see it
at the store any time soon.

It’s worth noting, though, that the company
showed off an 80-inch plasma screen at last year’s
show, again as a proof of concept, and ended up
announcing this year that it actually will be going

into production midway through 2005. That does-
n’t mean you’re necessarily going to be buying
one any time soon; the 80-inch model will retail
for about $39,999 and probably will be available
only by special order. Whether you pick up the 80-
inch model or wait for the 102-inch plasma
screen, this much is certain: you’ll probably have
to do some extensive surgery on your house or
apartment to get the thing in the door.

If you’re looking for something a bit more real-
istic, Samsung also has the 1080P-capable 67-inch
DLP television model. Sure, it’s quite a bit thicker
than the plasma screens, but at only $6,999, it’s a
bargain. If you’d prefer a flatter screen, the com-
pany’s 57-inch LCD screen is still a relatively
affordable $15,999, that is, if to you, affordable
means “My other cars are Jaguars and Porsches.”

SO WHATCHA GOT COOKIN’?
Yeah, yeah, so you connected your fridge to the
Internet a couple of years ago already, but how
about your oven, smarty pants? Now you can buy
an Internet-ready oven from TMIO, which stands
for Tonight’s Menu Intelligent Oven. It’s a two-
compartment wall oven that hooks to your home
network via Ethernet, Wi-Fi or powerline network-
ing. A touch-screen LCD panel above the top
compartment lets you program the oven, either
for cooking at a later time or if you want to cook
something now.

Both compartments can keep your food cool
during the day, until you send it the signal over
the Internet or from your cell phone; at that
point, it will start to cook your dinner for you,
so it will be ready when you arrive home. (You
also can use your cell phone to delay the start
time of a pre-programmed heating cycle, if you
are running late.)

The oven is $7,500, but installation is extra. (At
that price, ask them to throw in a pot roast too.)

DANCING ROBOTS
Yes, I promised dancing robots, so here they are. If
you have kids, there’s a really good chance that
you heard about the Robosapien, WowWee’s
remote-controlled robot, during last Christmas
season.

Well, get ready for Robosapien v2.0. The sec-
ond-generation Robo will be nearly twice the
height, at 24 inches, will have more joints—
including articulated fingers that actually can wrap
around items and pick them up—and will have a
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game-pad style remote control that allows more
natural movement. In fact, he’s limber enough
now to sit or lie down and can turn himself over.
Robo 2.0 also features more sensors, including
basic visual sensors that help him avoid collisions
with objects and allow him to determine whether
someone is in front of him. He’ll even ask where
you went if you move. Robo 2.0 still has 100 pre-
programmed functions, but now it also can act in
autonomous modes and even can control the
Robopet. Expect Robosapien 2.0 to be available at
the end of 2005, for about $200.

The Robopet, by the way, will be out mid-year.
It’s designed like a small dog, responds to sounds
and motion and has several moods, including
naughty. That’s right, it’ll probably pee on your
carpet—or at least pretend to. The Robopet will
run around $99.

Also out around the same time will be the
Roboraptor, a robotic dinosaur with a swinging
tail and a moving jaw, so it can chew on things
like your expensive sweater. It will also cost about
$99. Expensive sweater is not included.

A PDA ON 
YOUR WRIST
If you’re a fan of the
Palm personal organ-
izer, but don’t want
to have to carry one
around with you,
Fossil now has a pair
of Palm-powered wrist-
watches. Both models
come with PalmOS 4.1
onboard, 8MB of memory
and feature high-density
160x160 pixel greyscale
screens. They come with a tiny
stylus for interacting with the
screen, but you need to have nimble fingers to dig it
out of the side of the watch. The watches come
with address book, date book, to-do list, memo
pad, calculator and, of course, a time application.
They hook to a PC using USB and have an infrared
port for communicating with other Palm organizers.
The built-in Lithium Ion battery lasts between three
and four days between rechargings. The Abacus-
branded model will cost $199, and the Fossil-brand-
ed model will run $249.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six
years at Canada Computer Paper, first as
Products Editor at The Computer and
later at HUB Digital Living magazine. As a
freelancer, he has written for the Globe
and Mail, http://globetechnology.com,
HUB Digital Living, Computer Dealer

News, Homefront and CE-Biz. Although a relative newbie with
Linux (SUSE, thank you very much), he has extensive experience
with tech gadgets of all sorts and is enjoying figuring out which
ones are compatible with Linux.
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MEPIS is a Linux distribution that comes as a Live
CD. A Live CD is an operating system and set of
applications that will run if you simply boot your
PC from the CD drive instead of the hard drive.
MEPIS Linux appeared virtually out of nowhere, it
seemed, in 2003 and moved very swiftly into the
ranks of one of the most-favorite Linux distribu-
tions for desktop users. After using MEPIS, I can
see why.

The boot-up runs the Linux on the CD with-
out using your hard drive in any way, having no
effect on Windows or any other OS you have
already installed. This is a remarkable feat of
memory and disk management. It was first
made popular by Knoppix, a Linux distribution
from Klaus Knopper of Germany. In both cases,
the Live CD version of Linux creates a ramdisk
that simulates the file space of a disk with the
same amount of PC memory—then it loads
compressed files from the CD into the ramdisk
and runs the PC from that.

A Live CD lets you try out a new or different
distribution of Linux without having to install it
or alter the existing operating system on your
machine. It lets you show off that distribution
to friends on their own machines. It is also ideal
for giving a Linux demonstration in a classroom
or cybercafé.

Something at which Knoppix—and all its
children, including MEPIS—excels, is hardware
detection. Installing Linux was very often a
trial-and-error process of configuring video for
X-windows, installing sound drivers and the
like. On most common PCs from the last five
years, Live CDs start up with all the devices
detected and running. If you tried installing
Linux a few years ago and had a bad time, try
a Live CD distribution! If it detects all your
hardware, you know in minutes you simply can
install it with no hardware hassles; if it doesn’t,
you can try another, no time lost.

A Live CD has a few drawbacks, mostly that it
can be slow—very slow if you don’t have enough
memory to let it make a large ramdisk and have
enough left over to be the actual RAM! (For
MEPIS, as for most Linux Live CDs, 128MB is very
minimal, and you need 256MB for a decent expe-
rience with it.) When doing a demo with a Live
CD and things move slowly, it’s helpful to say
“this same operation takes only a few seconds if
you install and run it on you hard drive”, or your
audience could get the wrong impression about
Linux in general.

Live CD drawbacks would be huge in daily use,
of course. To save any work, you either must put
it on removable media like a floppy or USB drive

or burn a CD. (Some hard drive filesystems can be
mounted and used, but not a modern Windows
hard drive; you can read those but not write to
them. You can read and write to Windows 95, 98
and ME hard drives, though. And for all of them,
you need to understand Linux disk mounting at
least somewhat.) You cannot install any new soft-
ware, you can use only the packages on the Live
CD. And, did I mention slow?

However, a Live CD also lets you have your
own, eminently trustworthy operating system in,
say, a cybercafé where you don’t want to leave
bookmarks or bits of your e-mail files behind on
the disk for the next customer to enjoy. You might
want to use it at work if you need some Linux
application. And, many Live CDs, including MEPIS,
let you find and copy files from a Windows hard
drive that has become corrupted and won’t boot
anymore—so they can be a real lifesaver at
retrieving data!

MEPIS is distributed by a nearly one-man oper-
ation, being the consultancy of Warren Woodford,
a developer and analyst who has been in the busi-
ness long enough to remember punch cards. (To
get the first question out of the way, MEPIS does-
n’t mean anything—it’s just a word Warren liked
that wasn’t taken as a brand-name. This and
many other bits of trivia can be heard in a Linux

In Praise of MEPIS Linux
Roy Brander raves about the Live CD distribution called Simply MEPIS, possibly the ideal distribution for beginners or those who just want to try Linux.

REVIEWED BY ROY BRANDER
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Tech Show interview that is linked at the
top of the front page on the MEPIS Distro
site, http://www.mepis.org.)

Warren is clear that MEPIS is not the
result of any programming on his part—
his entire project is simply to build the
most fully featured, already-set-up,
already-configured, ready-to-go Linux
distribution for desktop users—and 
distribute that.

MEPIS is based upon Debian-testing,
the upcoming release of Debian dubbed
sarge, though it currently comes pack-
aged with both a Linux 2.6 kernel (the
latest) and a 2.4 kernel. Try the latest
2.6 kernel, but if you find hardware or
software incompatibility problems,
reboot and choose the 2.4 kernel. It will
become the new default.

MEPIS and other Live CD distributions
like Ubuntu inherit the strong, easily-to-
update, easy-to-add-software Debian
base from their Knoppix parent. Unlike
some distros, most controversially
Ubuntu, MEPIS still can be updated from
regular Debian repositories without

incompatibility problems.
The reason MEPIS stands out among

all the competing Live CD distros is its
attention to practical details and immedi-
ate usability. As Warren Woodford told
the Linux Tech Show interviewers, “There
is very little code in MEPIS; it’s a matter
of style, of package selection...KDE is
customized with scripts, with tweaks to
the application rc (configuration) files,
with XML to redesign the menus for
greater usability than they have as deliv-
ered from [the] KDE [project].” He
described his ambition as “to be the
Apple of the Linux world”.

MEPIS may be the only Linux distribu-
tion to have an unabashed fan site,
http://mepislovers.org. Woodford describes
his most ardent fans as “...people who
have never used Linux before, including a
lot of retired and semi-retired people. I get
letters from retirees who are now installing
it on their son’s and grandson’s computers,
just the reverse of what you normally
hear.” It was at this point in the interview
that a Linux Tech Show host broke in to

say that he’d been astonished to see MEPIS
on his father’s computer on his last visit
home: “... he hadn’t called me for any help
installing it—and I’d thought he was a die-
hard Windows fan.”

Users unfamiliar with other distribu-
tions may not appreciate the hundreds of
tweaks to the general usability of the
menus, utilities and applications, but
everybody who installs MEPIS immediately
appreciates the full configuration for
multimedia. MEPIS may be the only 
distribution going that comes out of the
box with all the add-ons, plugins and
viewers needed for the full Web-surfing
experience. Adobe Acrobat? There.
RealPlayer? Done. Quicktime? Supported.
Windows Media? Handled. (Well...most
of them...there are so many.) Some multi-
media types play in the browser via the
MozPlayer plugin, others are handed off
to the free media player, Xine. But you
can surf a very long time without running
into a file your MEPIS-tweaked Firefox
browser can’t open.�
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AND, MANY LIVE CDS, INCLUDING MEPIS, LET YOU FIND AND COPY FILES 
FROM A WINDOWS HARD DRIVE THAT HAS BECOME CORRUPTED 
AND WON’T BOOT ANYMORE—SO THEY CAN BE A REAL LIFESAVER 
AT RETRIEVING DATA!

Roy Brander is a
waterworks engineer
and sometime IT
manager. He chairs
the Calgary Unix
Users Group, which
provides meetings
and an Internet
forum for the UNIX
community in
Calgary, Canada. He
has lectured the US
defense community
on Risk Management
and the Titanic
disaster; materials
are now available 
at his Web site:
http://www.cuug.ab.ca/
branderr.
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Every now and then, we have a major develop-
ment in the world of Linux that may revolutionize
our desktop as we know it. With Autopackage,
we have a potential milestone that should have
been blatantly obvious. What’s the point of having
fantastic software designed for use by the average
Joe if the average Joe can’t figure out how to
install it? Autopackage aims to give users the sim-
ple Next→...Next→...Next→... interface that
Windows users have enjoyed for more than a
decade, and it just recently has matured to the
point of 1.0 status.

FEATURES
Autopackage provides packaging that is 
distribution-neutral. It doesn’t matter whether
you run an .rpm-, .deb- or Slackware-based
system, an autopackage will install without any
worries. Autopackage has the ability to install
new programs using a simple graphical 
program or, if you prefer, an elegant text-based
installer that shouldn’t be confusing for the

average Joe. There is even an option for
installing a program system-wide (the root
password is needed) or for a single user (no
password required).

What astounded me was I was expecting to
have to install some kind of core program to
begin with, but the autopackages simply ran and
installed whatever they needed to run without me
having to do a single thing! This self-contained
approach is extremely wise, as it is yet another
luxury to which Windows users are accustomed.

The package runs according to a script: check-
ing whether your PC has all of the 
necessary software installed before running,
installing the files, creating menu entries and plac-
ing the program in a central repository. This cen-
tral repository acts rather like Add/Remove
Programs under Windows, where the new pro-
gram can be removed easily later.

TESTING
I tried out Autopackage on a number of different

distributions, all varying in age. For the old, I had
a Red Hat 7.3 box; for the medium, Libranet
2.8.1; and for the new, Fedora Core 3.

All of the automated scripts hope your com-
puter is connected to the Internet so that the
script can download any libraries or programs
you need but don’t already have installed. If the
package you are installing finds everything it
needs already on your system, Autopackage
doesn’t need an Internet connection to work.

The first machine I tried it on was my
Libranet 2.8.1 machine, and everything simply
worked. I didn’t see any problems on my Fedora
Core 3 machine either, but an old off-line Red
Hat 7.3 box refused to run Autopackage,
because it was missing a vital library that Red
Hat 7.3 lacked. It may have worked if the Red
Hat 7.3 machine was connected to the Internet,
because Autopackage is geared toward on-line
usage, as noted above. When I tested it out on
some off-line machines, I had to download the
core autopackage program and copy it to the

Autopackage to the 
Software Installation Rescue
KPackage? apt-get? Yum? RPMs? DEBs? Who are we kidding? The non-geek world needs an easy-to-use installer
that doesn’t care about the difference between Linux distributions. Does Autopackage come to the rescue? 

REVIEWED BY JOHN KNIGHT
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same directory as the package I was installing
(grab it at http://autopackage.org/downloads/
latest/autopackage.tar.bz2).

The off-line version simply provides a text inter-
face, rather than a GUI. Although to my surprise, I
found that it feels nicer simply pressing Enter than
clicking on a GUI, albeit less pretty. This does make
package removal less intuitive though, as it lacks the
very nifty Manage 3rd Party Software program that
comes with the GUI. After a quick e-mail to Mike
Hearn, Autopackage’s main developer, he gave me a
link where you can download the program manually,
should you want to copy it to an off-line machine
later (ftp://ftp.sunsite.dk/projects/autopackage/
1.0.1/autopackage-gtk-1.0.1.x86.package).

STATE OF PLAY
Overall, Autopackage provides a nice interface
that easily rivals the interface you get with
Windows, if not exceeds it. Currently, there are
only a handful of packages available for down-

load, but the project has just recently matured,
and the number of packages should start increas-
ing as developers begin to see the advantage of
autopackages. Some major applications and desk-
tops should help garner some interest, like Xine
and MPlayer and, especially, KDE and GNOME. At
present, the coding isn’t stable enough to support
KDE properly, but after some more legwork, it
should be good to go.

Linux software installation is in an appalling
state at the moment, leaving average computer
users daunted and overwhelmed when it comes
to installing new software. Most distributions pro-
vide an on-line collection of software for their
users to download with a distribution-specific
tool, but this is unacceptable in the business
world. Under Windows and Mac OS, users simply
can buy a CD or download a file and install it
without thinking; this is not so under Linux, and
there’s absolutely no technical reason why we
can’t achieve the same thing.

Apathy is our biggest enemy, and in the words
of Autopackage developer Mike Hearn, “Really it’s
the Open Source community of developers that
will make or break this change. If the majority
decides that the old ’not my problem’ answer
given to users without a [good] package is unac-
ceptable and continue to take things into their
own hands, we’re doing well.”

Hopefully, distributions will start including
Autopackage by default, but it will take inter-
est and feedback from both users and develop-
ers. When I asked Mike about interest from 
distributors, he responded, “I’m not expecting
it to be bundled with distributions any time
soon. They all say they care lots about usability,
but their packaging systems are usually a
sacred bull: go anywhere near it and you get
your head bitten off.”

Autopackage makes the first major step
toward genuine mainstream viability with the
Linux desktop, albeit a fairly obvious one. If
new Linux users can install a any old piece of
software without thinking or being told how to
do it, then we’ll have a bright future and a
huge gap filled in usability.�

John Knight is a 20-year-old, rock-
climbing, Japan-loving megalomaniac,
trying to take over the world from his
bedroom via his keyboard. He spends
most of his time tinkering with MPlayer
and headbanging to his MP3s.
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WHAT ASTOUNDED ME WAS I WAS EXPECTING
TO HAVE TO INSTALL SOME KIND OF CORE
PROGRAM TO BEGIN WITH, BUT THE
AUTOPACKAGES SIMPLY RAN AND INSTALLED
WHATEVER THEY NEEDED TO RUN WITHOUT
ME HAVING TO DO A SINGLE THING!

http://autopackage.org/downloads/
ftp://ftp.sunsite.dk/projects/autopackage/
http://autopackage.org/downloads/latest/autopackage.tar.bz2
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TUX is the first and only magazine for
the new Linux user. In each digital edi-
tion of TUX, we explore every facet of
the modern Linux desktop, providing a
new breed of Linux user with the tools
and information to make their Linux
desktop experience complete.

A new breed of Linux user has emerged,
the Linux consumer. TUX delivers to this
powerful and rapidly growing economic
force by offerring many advertising
opportunities for both its digital edition
and its web site.
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UPCOMING ISSUES INCLUDE:

June 2005
The LIVING WITH WINDOWS Issue
Is yours a house (or office)
divided? With Linux PCs here
and Windows PCs there? In the
June 2005 issue, TUX shows
you all you need to know to
share files and folders between
these different systems. We'll
also look at tools that make
running Windows on Linux (and
vice versa) easy.

July 2005
The MONEY Issue
If money makes the world go
'round, this is a well rounded
issue of TUX as we explore finan-
cial applications in the Linux
world. We'll cover home finance
programs that provide simple
cheque book functions as well as
those that do it all. Join us as we
explore expense trackers, stock
tickers, and business-ready
accounting software. Ka-Ching!

August 2005
The EDUCATION Issue
TUX goes back to school in the
August 2005 issue. Linux systems
are a great solution for cash
strapped schools, but they offer
much more than inexpensive, 
stable, and secure systems. Kids 
will find software to challenge their
minds and have fun doing it. From
Linux at school, to educational 
programs, to educational games,
it's Linux for kids of all ages.

September 2005
The SWITCH Issue
Finally, it's time to help those in
need. Yes, we're talking about
people running something
other than Linux—those poor
unfortunate souls who deal
with adware, spyware, and 
system crashes every day of
their lives. TUX will look at great
Linux business tools, live Linux
CDs (to introduce your friends
and family), and transitional
applications (Linux programs
that are available for Windows)

so that even if they continue to
run something else, they can at
least get some of the benefits
of Linux.

October 2005
The LINUX AUTOMATION Issue
Whatever happened to computers
making our lives easier and giving
us more free time? Maybe it's
because they weren't running
Linux. This October 2005, TUX
will show you how to put your
Linux system to work while you
sleep! Let Linux take care of
business and watch over things
while you tend to other, more
important things. In this issue,
TUX will look at home security,
webcams and video surveillance,
maybe even a robot or two.

November 2005
The PERSONAL COMMUNICATIONS
Issue
As the end of 2005 approaches,
talk is hot again and Linux makes
it easy. The year 2000 has come
and gone, but picture phones are

finally here, instant messaging is
everywhere, free long distance
is a reality, and everybody is
reaching out and touching
somebody somewhere. Get into
the instant messaging, Voice
Over IP, text messaging, and just
plain talking action in the
November 2005 issue of TUX.

December 2005
The LINUX ON THE ROAD Issue
It's December 2005 and people
are on the move, whether to visit
family for the holidays or jetting
off to somewhere warmer. Either
way, you'll need to take your
Linux computer along. Don't
have one yet? Not sure of the
tools you'll need? Let TUX show
you the best tools for Linux 
notebooks, network applications,
WiFi, Bluetooth, and everything
else you need to stay connected
when you are away from home.
We'll take a close look at personal
digital assistants, cell phones,
and much more when TUX hits
the road.

TUX magazine

http://www.tuxmagazine.com
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